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-stderrWindow send stderr to a popup window instead of a terminal

-style s specify the widget style used by the front end

-topDirectory dir specify the location of the Mathematica installation direc-
tory

-version print the current version of the front end on the command
line

mathematica command-line options.

The default for -backgroundTaskDelay is 100 milliseconds.

The option -cleanStart will ignore the caches stored in the directory
$UserBaseDirectory/FrontEnd/7.0_ Caches, and will rebuild the front end preferences
file, $UserBaseDirectory/FrontEnd/init.m. This option can also be abbreviated as

-clean.

When using -font, a list of possible font names can be found by using xfontsel. The name

can be expressed either as an X Logical Font Description or as a valid font alias.
The option -1mverbose is usefull for debuggin problems related to the license server

The option -mathlink may be useful when the front end is used as a typesetting or graphics
rendering service. See www.wolfram.com/solutions/mathlink for additional information about
MathLink.

The default directory for —-preferencesDirectory is ~/.Mathematica.

The option -singleLaunch will prohibit multiple front end launches only if the current front end
was launched with the -singleLaunch option.

Valid styles for -style are motif, motifplus, windows, cde, platinum, sgi, and compact.

The defaut location for -topDirectory is /usr/local/Wolfram/Mathematica/7.0.

Testing the Installation on Unix and Linux

The following simple commands allow you to test the installation of Mathematica. Running
these commands does not guarantee that the installation was successful, but a failed command

can indicate that a serious problem occurred during installation.

You should run these tests from a regular user account and not from an account with administra-
tor privileges.
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To run Mathematica using a network license, both the client machine and the license server
must be on the network and MathLM must be running.

If you run into problems when doing these tests, see the troubleshooting tips in "Trouble-
shooting on Unix and Linux". If you do not find the answer there, check the Technical Support

website at support.wolfram.com/mathematica.

1. To start the kernel, type math in a shell and press Enter.
In[1l]:=

2. Type N[Pi, 20] and press Enter. The number in the output should match the output
shown here.

In[l]:= N[Pi, 20]
Out[l]= 3.1415926535897932385

In[2]:=

3. To exit the kernel, type Exit and press Enter.

On Unix and Linux, you can test the kernel on a remote machine by using the command ssh
hostname /usr/local/bin/math. (The exact pathname could be different depending on how
Mathematica was installed.) This command will launch the kernel on the remote machine host-

name. When you see the In[ 1] label, follow step 2 and step 3 in the previous instructions.

1. Make sure that you are running X. Launch Mathematica by typing mathematica in a shell
and pressing Enter.

Alternatively, you can select Mathematica from the menu folder Wolfram.

A splash screen with initialization information appears briefly, after which an empty note-
book and the Welcome Screen appear.

2. Type N[Pi,20]. Then hold down the Shift key and press Enter to evaluate. This should
send the command to the kernel and return the same result as before. The In[1] and
out[ 1] labels are prepended once the evaluation is completed.

In the notebook window, there should be a horizontal line across the notebook; this is the
horizontal insertion bar. If you do not see one, move the pointer until it becomes a horizon-
tal I-beam and click once to see the insertion bar.
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3. Press the Esc key. You should see three small horizontal lines in a column (:). Type int
and press Esc again. You should see an integral sign (f). As an additional font check,
typing \[CheckmarkedBox] and \[CirclePlus] should print the symbols ¥ and o,
respectively. If the symbols show up correctly, the fonts have been properly installed.

4. From the Help menu, choose Documentation Center. The Mathematica Documentation
Center should appear.

On Unix and Linux, you can test the X front end remotely, provided the ssh server on the

remote machine allows X forwarding. You must be running X on the local machine to do this. In

a shell, type ssh -X hostname /usr/local/bin/mathematica. (The exact pathname could be

different depending on how Mathematica was installed.) This command will launch Mathematica

on the remote machine hostname. When the splash screen appears on your screen, follow step 2

and step 3 in the previous instructions.

Configuration Files on Unix and Linux

Mathematica stores preference settings and initialization data in two directories,

$BaseDirectory and $UserBaseDirectory. Within each of these directories are several possi-

ble subdirectories with titles such as FrontEnd, Kernel, and Licensing.

m Global settings that affect all users are stored in subdirectories of the directory
$BaseDirectory. The default value of $BaseDirectory on Unix and Linux is

/usr/share/Mathematica. To redefine the location of global preference settings and
initialization data, set the environment variable MATHEMATICA_BASE.

m Settings that only affect a particular user are stored in subdirectories of the directory
$SUserBaseDirectory, which is typically a subdirectory of the user’s home directory. The
default value of $UserBaseDirectory on Unix and Linux is ~/.Mathematica. To redefine
the location of user preferences and initialization data, set the environment variable
MATHEMATICA_USERBASE.

Settings in the directory $UserBaseDirectory override global settings defined in the directory

$BaseDirectory.

In the pathnames that follow, replace the variables $BaseDirectory and $UserBaseDirectory
with the appropriate directories for your system. To find their locations on your system, evalu-

ate the command $BaseDirectory (Or $UserBaseDirectory) in @ Mathematica notebook.

The initialization files used by the kernel contain Mathematica commands that are evaluated at
startup, such as function definitions, packages to load, or kernel option settings. These com-

mands are also available to the Mathematica front end.
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$BaseDirectory/Kernel/init.m

This file is used to initialize the kernel and therefore should store any kernel commands
that are appropriate for all users running the kernel.

SUserBaseDirectory/Kernel/init.m
This file stores user-specific commands used to initialize the kernel.

Kernel initialization files are not created automatically.

Front end initialization files store preference settings such as the values of global options in the
Option Inspector. These files are automatically updated by Mathematica when you change a
setting in the front end. To make changes to this file, make your changes from within Mathemat-

ica rather than editing the file directly.
$BaseDirectory/FrontEnd/init.m

This file stores systemwide defaults used by all Mathematica front ends. The settings in
this file affect all users. "Systemwide Defaults on Unix and Linux" explains how to imple-
ment changes to this global file.

SUserBaseDirectory/FrontEnd/init.m
This file defines settings within the front end that are specific to each user.
$UserBaseDirectory/FrontEnd/7.0 Caches/

This directory within the user’s home directory stores information on system settings that
are read by the front end.

Front end initialization files are created automatically.

Passwords are stored in the mathpass file, described in further detail in "Registration and
Passwords". In the following pathname, replace the variable $InstallationDirectory with the
directory where you installed Mathematica. The default value of $InstallationDirectory on
Unix and Linux is /usr/local/Wolfram/Mathematica/7.0. To find the value of
$InstallationDirectory on your system, evaluate the command $InstallationDirectory

in a Mathematica notebook.
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$BaseDirectory/Licensing/mathpass

This is the default location for the global password file.
$InstallationDirectory/Configuration/Licensing/mathpass
This is an alternative location for the global password file.
SUserBaseDirectory/Licensing/mathpass

While this is not normally the location for the password file, a user-specific mathpass file
can be stored here.

Systemwide Defaults on Unix and Linux

If you have installed Mathematica in a location where multiple users run it (for example, on a
file server or multi-user machine), then you can set up systemwide defaults for the Mathemat-
ica front end and kernel. This is ideal for setting up Mathematica for use in computer labs and
classrooms. If you share the directory $BaseDirectory across the network, these defaults will

also take effect on local installations that use the shared $BaseDirectory.

The following instructions assume that $BaseDirectory and $UserBaseDirectory have their

default values, /usr/share/Mathematica and ~/.Mathematica respectively.

1. Launch Mathematica, and set up any changes to the front end that you need. For exam-
ple, you may want to modify default file locations, language options, or menu settings.

2. Quit Mathematica.

3. Copy the file ~/.Mathematica/FrontEnd/init.m to the directory /usr/share/
Mathematica/FrontEnd.

These settings will now be used by the front end unless overridden by the local init.m file stored

in the user’s directory ~/.Mathematica/FrontEnd.

1. Launch Mathematica, and create a new file.

2. Add any Mathematica commands that should be evaluated on startup. For example, you
may want to add a function definition or display a message at startup. Enter all the com-
mands in the same cell, separating commands with semicolons.
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3. Make this cell an initialization cell by selecting the cell bracket and then choosing Cell »
Cell Properties » Initialization Cell.

4. When you have finished making your changes, choose File » Save and select
Mathematica Package from the Save as type popup menu. Then save the file as
/usr/share/Mathematica/Kernel/init.m.

These commands will be evaluated when users launch Mathematica. If you added a function
definition, that function will be available to all users.

Fonts on Unix and Linux

Dealing with fonts under Unix and Linux can sometimes be tricky. The important issues in

dealing with fonts in Mathematica are presented here for your convenience.

The Mathematica front end supports BDF, TrueType, and Typel fonts. These fonts are automati-
cally installed by MathInstaller during installation.

All machines that display the front end must have access to the fonts included with Mathemat-
ica. If the Mathematica process is running on a remote machine and the front end is displayed
on the local machine, the X server on the local machine must know where to find the Mathemat-
ica fonts. To do this, add the Mathematica fonts to the local font path by running a command
like the following on the local machine.

xset fp+ /usr/local/Wolfram/Mathematica/7.0/SystemFiles/Fonts/Typel; xset f£p

rehash
Be sure to execute xset fp rehash to make the fonts available to the local X server.

For optimal onscreen performance, Typel fonts should appear before BDF fonts in the font
path. Hence, $InstallationDirectory/SystemFiles/Fonts/Typel should appear before
$InstallationDirectory/SystemFiles/Fonts/BDF. You can check the order of the font
path by executing the command xset q.

Note: TrueType fonts are automatically loaded and do not require an xset command.
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You may prefer not to install local copies of the Mathematica fonts on all machines. You can
instead set up a font server with all the necessary Mathematica fonts. The other machines on
the network can then find the fonts as needed by reading them from the Mathematica directory

on the font server. Consult your operating system’s documentation for further information.

On some systems, the font path is limited in length, and it is possible to receive xset: bad
font path element errors even if the fonts are available to the server. In this case, try reorder
ing the font path and adding the directories for the Mathematica fonts earlier in the path. The
directory $InstallationDirectory/SystemFiles/Fonts/Typel must be listed before
SInstallationDirectory/SystemFiles/Fonts/BDF on the font path for optimal onscreen

performance.

When the X front end prints a notebook, it uses AFM files for the font metrics needed
for printing. If you want to print using a particular font not included with Mathematica,
you will need the AFM files for the font. These files are installed in either
$InstallationDirectory/Configuration/Fonts/AFM, /usr/lib/AFM, or /usr/lib/afm.
Fonts are normally downloaded to the printer by the front end when printing. You may be able
to download the fonts and store them on the printer. See the documentation and programs that
came with your printer for more information.

If you want to view Mathematica graphics using GhostScript, you need to make GhostScript
aware of the Mathematica fonts. For more information, contact Technical Support by sending
email to support@wolfram.com, or visit support.wolfram.com/mathematica/graphics/export
/ghostscript.html.
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Troubleshooting on Unix and Linux

If you have problems using Mathematica on Unix or Linux, check this list for solutions.

s Make sure the CD or DVD is properly mounted with the correct mount command (see
"Mounting a CD or DVD on Unix and Linux"). If the filenames on the CD/DVD appear in the
wrong case, it means the CD/DVD is mounted incorrectly.

Make sure to run the installer from the directory in which it is located.

If the front end password dialog box appears when you launch Mathematica, either Mathemat-
ica could not locate the mathpass file or there was no valid password in the mathpass file.
To resolve this problem, first check that there is a mathpass file in one of these directories:
/usr/share/Mathematica/Licensing, $InstallationDirectory/Configuration/Licensing,
or ~/.Mathematica/Licensing. If you did not find a mathpass file in these locations, follow

the instructions in "Entering a Single-Machine Password" to reenter your password.

If there is a mathpass file in one of those directories, the password or passwords are invalid.
Make sure that your MathID number matches the MathID number used to issue your password.
If your MathID number changes, you will need to contact Customer Service to get a new pass-
word. Contact information is provided in "Registration and Passwords".

Front end preferences, such as the names of recently opened and saved files, are stored in
~/.Mathematica/FrontEnd. The most convenient way to reset the front end preferences to
their default values is to restart Mathematica using the command mathematica -cleanStart.

This will cause the initialization file to be rebuilt automatically.
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Information about your Mathematica layout, such as the locations of text resource files, is
stored in caches. These caches are located in the directory ~/.Mathematica/FrontEnd/
7.0 _Caches. A corrupted cache may cause the front end to produce an error or quit immedi-
ately on startup. The most convenient way to reset the caches to their default values is to use
the option -cleanstart at startup. This will cause the Mathematica caches and the initializa-
tion file to be rebuilt automatically. If you want to rebuild your caches but retain your prefer-
ences, hold down Shift during startup. This will delete and rebuild the cache without rebuilding
the front end initialization file.

m Make sure that the fonts are installed on the machine that displays the front end or on a
font server.

m If you see the error xset: bad font path element, either the fonts are not properly
installed on your machine, or your font path is too long and exceeds the allowable limit.
Make sure the fonts are properly installed, or copy the fonts to a directory that is already on
the font path.

For further assistance, check the Technical Support FAQs on the web at support.wolfram.com.
If you are a Site License Administrator, additional Site License Documentation is available at
site.wolfram.com. If you do not find the information you need, please contact Technical Support
by sending email to support@wolfram.com or by calling +1-217-398-6500. Include your license
number in all correspondence. Your license number is located on your electronic or printed
license certificate. It is also available after installation by going to the Help menu and clicking
About Mathematica. You must be a registered user in order to receive installation support.

You must have a current Premier Service subscription to receive Technical Support.
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Mac OS X
Installing Mathematica on Mac OS X

Requirements

Mathematica is available for Windows, Unix, Linux, and Mac OS X. For a complete list of plat-
form availability, visit www.wolfram.com/products/mathematica/platforms.html. Any supported
machine can act as a client for running Mathematica, provided the following two conditions are
met:

m The client has access to the Mathematica files, either locally or from a file server on the
network.

m The license server running MathLM is available on the TCP/IP network.

A license server can also function as its own client. However, this is not recommended. If the
machine has to be rebooted for any reason, the serving of licenses to all other clients on the

network may be disrupted.

Before you install Mathematica as a license server client, MathLM should already be installed
and running on a license server on the network (see "Installing MathLM" for details). To com-
plete the Mathematica installation, you will need to know the name or IP address of the license

server running MathLM.

To install Mathematica on Mac OS X in the Applications folder, you must log on as

administrator.
To Install Mathematica:

1. Insert the DVD. A new window appears on your screen.

00 || Mathematica ]
X 2 items, 486.7 MB available

Wolfram
Mathematica’7

Drag the Mathematica icon to Open the Applications folder
the Applications folder to install and start Mathematica

b

Mathematica

”
~
Applications
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2. Drag the Mathematica icon from this window to the location on your hard drive where you
want to install Mathematica. In order for all users to have access to Mathematica, you
should install it in the systemwide Applications folder. You must have administrative
privileges to do this.

Note: If you are installing over a previous version of Mathematica, your existing math-
pass file and custom settings will not be deleted.

3. When all files have been copied, launch Mathematica by opening the folder where you
installed Mathematica and double-clicking the Mathematica icon.

4. Mathematica starts up and the following dialog box appears. Select Network license.
Then enter the name or IP address of the MathLM license server in the text field provided.

8,006

Wolfram Mathematica7

Please personalize your copy of Mathematica

(O Single machine
Name
Organization
License number

A password specific to this machine will be required. Please enter your name
and/or organization and your license number, then click OK to continue.

@ Network license

Enter the name of a server running a Mathematica license manager:

You will obtain a license from a server on your local network each time
Mathematica is launched.

) ——
2 Quit

5. Click OK. Mathematica launches and is ready for use.

After you install Mathematica you can place the Mathematica icon into the Dock for easier
access. To do this, start Mathematica, and hold down the Ctrl key while clicking the Mathemat-
ica icon in the Dock. In the popup menu that appears, choose Keep in Dock.

Follow these instructions to install a standalone copy of Mathematica that does not get a license
from the license server. Depending on your license type, this may require contacting Wolfram

Research to purchase additional licenses.

To run Mathematica, you must register with Wolfram Research and receive a password. See

"Registration and Passwords" for further information.



86 | System Administration for Network Licenses

To Install a Single-Machine Copy of Mathematica on Mac OS X:

1. Insert the Mathematica DVD. A new window appears on your screen.

000 __| Mathematica )
X 2 items, 486.7 MB available

Wolfram
Mathematica7

Drag the Mathematica icon to Open the Applications folder
the Applications folder to install and start Mathematica
% 7=
”
Mathematica Applications

© 1983-2008 Wolfram Research, Ine

2. Drag the Mathematica icon from the window to the location on your hard drive where you
want to install Mathematica.

Note: If you are installing over a previous version of Mathematica, your existing math-
pass file and custom settings will not be deleted.

3. When all files have been copied, launch Mathematica by opening the folder where you
installed Mathematica and double-clicking the Mathematica icon.

4. Mathematica starts up and the following dialog box appears. Select Single machine.
Enter your name, the name of your organization, and your license number (located on
your electronic or printed certificate) in the text fields provided. Click OK when you are
done.

8eno

Wolfram Mathematica’7

Please personalize your copy of Mathematica

@ Single machine

Name:

Organization:

License number:

A password specific to this machine will be required. Please enter your name
and/or organization and your license number, then click OK to continue.

(O Network license

Enter the name of a server running a Mathematica license manager:

You will obtain a license from a server on your local network each time
Mathematica is launched.

6\ _ Quit
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5. The following dialog box appears showing the MathID number for your machine. To obtain
your password, click the Web button, go to register.wolfram.com, or contact Wolfram
Research (see "Registration and Passwords" for further information). You will need to
supply your license number and your MathID number.

8no

Wolfram Mathematica’7

The quickest and easiest way to obtain a password is to register on the web.
Click the Web button to open your web browser and register to obtain your
password.

MathiD: [5116-81117-36320

Password: ( web )

NOTE: The information you provide when you register will be used at Wolfram
Research. Your information will never be sold or provided to anyone else.

(" Other Ways to Register (" Back

6. Enter your password and click OK. You are now ready to start using Mathematica.

Installing Mathematica from a File Server

One convenient way to install Mathematica on a client is to copy the files from a file server on
the network. This is an efficient way of making Mathematica available to a large number of
users without having to supply a DVD to each user.

Before following these instructions, Mathematica should be installed on the file server according
to the instructions in "Network License" and "Single-Machine License".

To Install Mathematica from a File Server:

1. On the client machine, select Go » Connect to Server in the Finder menu.

2. In the dialog box that appears, choose a file server from the list or enter the machine
name or IP address of the file server in the text field. Then click Connect.

a0 Connect To Server

Server Address:

afp://macserver.domain.com + G,

Favorite Servers:

¥ macserver.domain.com

Remove [ Browse '_.I ( Connect )

)
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3. Enter your name and password in the dialog box that appears. Then click Connect.

— Connect to the file server "MacServer" as:
-
¢ 3
(- )

) Guest
® Registered User

Name: John Doe
Password: sensae
r; Options... ",'I (" Cancel ",I f Connect )

4. A dialog box appears, showing a list of volumes on the file server. Select the volume in
which Mathematica is installed. Then click OK.

MacServer
-
Select the volumes you wish to mount
| N

Apps
Archives
Drop Box

Web Folder

Character Set: Western (Mac) ?}

( Cancel i-' ok )

5. The volume you selected is mounted on the client machine. Double-click the icon represent
ing the volume.

6. Navigate to the location where Mathematica is installed. Then drag the Mathematica
package from the file server to the location on the client machine where you want to
install Mathematica. In order for all users to have access to Mathematica, you should
install it in the Applications folder. You must log on as administrator to do this.
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Launching Mathematica on Mac OS X

To run Mathematica using a network license, both the client machine and the license server
must be on the network and MathLM must be running.

To Launch Mathematica:

Double-click the Mathematica icon in the directory where Mathematica is installed. Alterna-

tively, if you have placed the Mathematica icon in the dock, single-click the icon.

To Launch Only the Mathematica Kernel:

Open the Terminal application and type the full pathname of the MathKernel binary in the
window that appears. For example, if you installed Mathematica in the Applications folder,
type /Applications/Mathematica.app/Contents/MacOS/MathKernel in a Terminal win-
dow and press Return.

To maintain a centralized location for preferences and password files or to save disk space, you
can run Mathematica directly from a file server. To do this, the client machine does not need to
have any Mathematica files installed locally.

To Run a Copy of Mathematica Installed on a Remote File Server:
1. Connect to a file server on which Mathematica is installed.

2. Double-click the icon representing the volume with the Mathematica files. Then navigate
to the location where Mathematica is installed.

3. Double-click the Mathematica icon in the directory where Mathematica is installed.

The commands MathKernel and Mathematica have several command-line options used to
specify certain configuration information and file locations.

MathKernel

The command MathKernel starts the kernel, which is the part of Mathematica that handles

calculations. This command is also used by the Mathematica front end.
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-initfile file Specifies the name of a file containing commands to be run
on startup.
-lmverbose Prints diagnostic information to stderr on connecting to

the license manager. This is useful for debugging problems
related to the license server.

-mathlink Specifies that the kernel should be run in MathLink mode.
See www.wolfram.com/solutions/mathlink for additional
information about MathLink.

-noinit Specifies that no initialization file should be read at startup.

-password str Specifies a password to use instead of the password or
passwords stored in the mathpass file. The password
should have the form "Iservername" or "machinename mathid
licensenumber password".

-pwfile file Specifies the name of a file that has a valid password.

-run Takes a command to be run on startup as an argument.
MathKernel command-line options.
Mathematica
The command Mathematica runs the Mathematica front end. In order to run Mathematica with

a command-line option, you must start it from the command line using the Terminal applica-
tion.

-cleanStart Tells the front end to ignore caches stored in the directory
~/Library/Mathematica/FrontEnd/7.0 Caches, and rebuilds
the front end preferences file,
~/Library/Mathematica/FrontEnd/init.m.

-mathlink Causes the front end to run in MathLink mode. In MathLink
mode, the front end runs as a child process that is capable
of accepting MathLink packets. This option may be useful
when the front end is used as a typesetting or graphics
rendering service.

-preferencesDirectory dir Specifies the location where preference settings are stored.
The default location is ~/Library/Mathematica.

-topDirectory dir Specifies the location of the Mathematica installation
directory.

Mathematica command-line options.
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Testing the Installation on Mac OS X

The following simple commands allow you to test the installation of Mathematica. Running
these commands does not guarantee that the installation was successful, but a failed command

can indicate that a serious problem occurred during installation.

You should run these tests from a regular user account and not from an account with administra-
tor privileges.

To run Mathematica using a network license, both the client machine and the license server

must be on the network and MathLM must be running.

If you run into problems when doing these tests, see the troubleshooting tips in "Trouble-
shooting on Mac OS X". If you do not find the answer there, check the Technical Support web-

site at support.wolfram.com/mathematica.

1. To start the kernel, open the Terminal application and type the full pathname of the
MathKernel binary in the window that appears. For example, if you installed Mathematica
in the Applications folder, type /Applications/Mathematica.app/Contents/MacOS/
MathKernel in a Terminal window and press Return.

In[l]:=

2. Type N[Pi, 20] and press Return. The number in the output should match the output

shown here.
In[l]:= N[Pi, 20]
Out[l]= 3.1415926535897932385

In[2]:

3. To exit the kernel, type Exit and press Return.
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1. Launch Mathematica by double-clicking the Mathematica icon.

A splash screen with initialization information appears briefly, after which an empty note-
book and the Welcome Screen appear.

2. Type N[Pi,20]. Then hold down the Shift key and press Enter to evaluate. This should
send the command to the kernel and return the same result as before. The In[1] and
out[1] labels are prepended once the evaluation is completed.

In the notebook window, there should be a horizontal line across the notebook; this is the
horizontal insertion bar. If you do not see one, move the pointer until it becomes a horizon-
tal I-beam and click once to see the insertion bar.

3. Press the Esc key. You should see three small horizontal lines in a column (z). Type int
and press Esc again. You should see an integral sign (f). As an additional font check,
typing \[CheckmarkedBox] and \[CirclePlus] should print the symbols ¥ and ¢,
respectively. If the symbols show up correctly, the fonts have been properly installed.

4. From the Help menu, choose Documentation Center. The Mathematica Documentation
Center should appear.

Configuration Files on Mac OS X

Mathematica stores preference settings and initialization data in two directories,
$BaseDirectory and $UserBaseDirectory. Within each of these directories are several possi-
ble subdirectories with titles such as FrontEnd, Kernel, and Licensing.

m Global settings that affect all users are stored in subdirectories of the directory
$BaseDirectory. The default value of $BaseDirectory on Mac O0OS X is
/Library/Mathematica. To redefine the location of global preference settings and initializa-
tion data, set the environment variable MATHEMATICA_BASE.

m Settings that only affect a particular user are stored in subdirectories of the directory
$UserBaseDirectory, which is typically a subdirectory of the user's home directory. The
default value of $UserBaseDirectory on Mac OS X is ~/Library/Mathematica. To redefine
the location of user preferences and initialization data, set the environment variable
MATHEMATICA_USERBASE.
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Settings in the directory $UserBaseDirectory override global settings defined in the directory

$BaseDirectory.

In the pathnames that follow, replace the variables $BaseDirectory and $UserBaseDirectory
with the appropriate directories for your system. To find their locations on your system, evalu-

ate the command $BaseDirectory (Or $UserBaseDirectory) in @ Mathematica notebook.

The initialization files used by the kernel contain Mathematica commands that are evaluated at
startup, such as function definitions, packages to load, or kernel option settings. These com-

mands are also available to the Mathematica front end.
$BaseDirectory/Kernel/init.m

This file is used to initialize the kernel and therefore should store any kernel commands
that are appropriate for all users running the kernel.

$UserBaseDirectory/Kernel/init.m

This file stores user-specific commands used to initialize the kernel.

Kernel initialization files are not created automatically.

Front end initialization files store preference settings such as the values of global options in the
Option Inspector. These files are automatically updated by Mathematica when you change a
setting in the front end. To make changes to this file, make your changes from within Mathemat-

ica rather than editing the file directly.
$BaseDirectory/FrontEnd/init.m

This file stores systemwide defaults used by all Mathematica front ends. The settings in
this file affect all users. "Systemwide Defaults on Mac OS X" explains how to implement
changes to this global file.

$UserBaseDirectory/FrontEnd/init.m
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This file defines settings within the front end that are specific to each user.
$UserBaseDirectory/FrontEnd/7.0 Caches/

This directory within the user's home directory stores information on system settings that
are read by the front end.

Front end initialization files are created automatically.

Passwords are stored in the mathpass file, described in further detail in "Registration and Pass-
words". In the following pathname, replace the variable $InstallationDirectory with the
directory where you installed Mathematica. To find the value of $InstallationDirectory oOn

your system, evaluate the command $InstallationDirectory in a Mathematica notebook.
$BaseDirectory/Licensing/mathpass
This is the default location for the global password file.
$InstallationDirectory/Configuration/Licensing/mathpass
This is an alternative location for the global password file.
SUserBaseDirectory/Licensing/mathpass

While this is not normally the location for the password file, a user-specific mathpass file
can be stored here.

Systemwide Defaults on Mac OS X

If you have installed Mathematica in a location where multiple users run it (for example, on a
file server or multi-user machine), then you can set up systemwide defaults for the Mathemat-
ica front end and kernel. This is ideal for setting up Mathematica for use in computer labs and
classrooms. If you share the directory $BaseDirectory across the network, these defaults will
also take effect on local installations that use the shared $BaseDirectory.

The following instructions assume that $BaseDirectory and $UserBaseDirectory have their

default values, /Library/Mathematica and ~/Library/Mathematica, respectively.

1. Launch Mathematica, and set up any changes to the front end that you need. For exam-
ple, you may want to modify default file locations, language options, or menu settings.



System Administration for Network Licenses | 95

2. Quit Mathematica.

3. Copy the file ~/Library/Mathematica/FrontEnd/init.tm to the directory /Library/
Mathematica/FrontEnd.
These settings will now be used by the front end unless overridden by the local init.m file stored

in the user's ~/Library/Mathematica/FrontEnd directory.

1. Launch Mathematica, and create a new file.

2. Add any Mathematica commands that should be evaluated on startup. For example, you
may want to add a function definition or display a message at startup. Enter all the com-
mands in the same cell, separating commands with semicolons.

3. Make this cell an initialization cell by selecting the cell bracket and then choosing Cell »
Cell Properties » Initialization Cell.

4. When you have finished making your changes, choose File » Save and select
Mathematica Package from the Save as type popup menu. Then save the file as
/Library/Mathematica/Kernel/init.m.

These commands will be evaluated when users launch Mathematica. If you added a function
definition, that function will be available to all users.

Troubleshooting on Mac OS X

If the front end password dialog box appears when you launch Mathematica, either Mathemat-
ica could not locate the mathpass file or there was no valid password in the mathpass file. To
resolve this problem, first check that there is a mathpass file in one of these directories:
/Library/Mathematica/Licensing, $InstallationDirectory/Configuration/Licensing, or
~/Library/Mathematica/Licensing. To find the exact location of $InstallationDirectory on
your machine, evaluate the command $InstallationDirectory in a notebook. If you did not
find a mathpass file in these locations, follow the instructions in "Entering a Single-Machine

Password" to reenter your password.

If there is a mathpass file in one of those directories, the password or passwords are invalid.
Make sure that your MathID number matches the MathID number used to issue your password.
If your MathID number changes, you will need to contact Customer Service to get a new pass-

word. Contact information is provided in "Registration and Passwords".
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Front end preferences, such as the locations of recently opened and saved files, are stored
in a front end initialization file called init.m. This file is located in the directory ~/Library/
Mathematica/FrontEnd. If you need to reset the front end preferences to their default values,
hold down Shift+Option during startup. This will cause the initialization file to be rebuilt automat-

ically.

Information about your Mathematica system layout, such as the locations of text resource
files and help files, is stored in caches. These caches are located in the directory ~/Library/
Mathematica/FrontEnd/7.0/ Caches.

A corrupted cache may cause the front end to produce an error or quit immediately on startup.
The most convenient way to restore the caches to their default values is to hold down
Shift+Option during startup. This will cause the Mathematica caches and the initialization file to

be rebuilt automatically.

If you want to rebuild your caches but retain your preferences, hold down Shift during startup.
This will delete and rebuild the cache without rebuilding your front end initialization file.

For further assistance, check the Technical Support FAQs on the web at support.wolfram.com.
If you are a Site License Administrator, additional Site License Documentation is available at
site.wolfram.com. If you do not find the information you need, please contact Technical Support
by sending email to support@wolfram.com or by calling +1-217-398-6500. Include your license
number in all correspondence. Your license number is located on your electronic or printed
license certificate. It is also available after installation by going to the Help menu and clicking
About Mathematica. You must be a registered user in order to receive installation support.

You must have a current Premier Service subscription to receive Technical Support.
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Mathematica

Windows

Installing Mathematica on Windows

Requirements

Mathematica is available for Windows, Unix, Linux, and Mac OS X. For a complete list of plat-
form availability, visit www.wolfram.com/products/mathematica/platforms.html. Any supported
machine can act as a client for running Mathematica, provided the following two conditions are
met:

m The client has access to the Mathematica files, either locally or from a file server on the
network.

m The license server running MathLM is available on the TCP/IP network.

A license server can also function as its own client. However, this is not recommended. If the
machine has to be rebooted for any reason, the serving of licenses to all other clients on the

network may be disrupted.

Before you install Mathematica as a license server client, MathLM should already be installed
and running on a license server on the network (see "Installing MathLM" for details). To com-
plete the Mathematica installation, you will need to know the name or IP address of the license

server running MathLM.

To install Mathematica on Windows 2000/XP/Vista, you must have administrative privileges.
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To Install Mathematica:

1. Insert the Mathematica DVD. The Wolfram Mathematica 7 window appears on your
screen. Click the button labeled Install Mathematica to a hard disk.

3% Wolfram Mathematica 7 w

Wolfram
Mathematica™7

Install Mathematica
to a hard disk

©1988-2008 Wolfram Research, Inc.

2. The Wolfram Mathematica Setup dialog appears on your screen. Click Next to begin
the installation process.

E Wolfram Mathematica Setup UEE

Wolfram Mathematica Setup

This will install Wolfram Mathematica 7 on your computer.

L Mext > i [ Cancel ]
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3. By default, Mathematica is installed in the directory C:\Program Files\Wolfram Research\

Mathematica\7.0. To choose another destination
continue.

directory, click Browse. Click Next to

(=]

4% Wolfram Mathematica Setup

o

Destination Location
Where should Walfram Mathematica be installed?

J Setup will install Wolfram hathematica into the following folder.

To continue, click Nest. If you would like to select a different folder, click Browse.

C:\Program Files\waolfram ResearchiMathematicat7.0f

At least 1,443.6 MB of free disk space is required.

i

Browse...

[ < Back ” MNext >

l[ Cancel ]

4. Mathematica is configured to automatically install all optional components. To chose

another configuration, de-select any components
box. Click Next to continue.

by clicking on the corresponding check

=]

4% Wolfram Mathematica Setup

& %)

Select Components
Which components should be installed?

*

Select the components you want ta install; clear the components you do not want to
install. Click Mext when you are ready to continue.

|il.!n.§.t.§!!...a..l.l..99megngn.t.%..[.r..e...c“qmm.e..ndedl

[v]

2.0ME
2.0ME

Optional Components
Mathematica Motebook Indexers

Current selection requires at least 1,448.6 MB of disk space.

< Back Nexst >

I

] [ Cancel
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5. Click Next to add Mathematica shortcuts to the Start menu in the Wolfram Mathematica
folder. If you would like to select a different folder, click Browse.

i€ Wolfram Mathematica Setup E] [
Start Menu Folder
Where should Setup place the program's shortcuts?

Setup will create the program's shortcuts in the following Start Menu folder.

To continue, click Nest. If you would like to select a different folder, click Browse.

‘wolfram Mathematics

[C]Dan't create a Start Menu folder

[ < Back ” Mext » ]I Cancel

6. Click Install to install Mathematica.

4% Wolfram Mathematica Setup E] O
Ready to Install
Setup iz now ready to begin installing ‘walfram kMathematica on vour computer.
Click Install to continue with the installation, or click Back if you want to change any
zettings.

Destination location:
C:%Program Files'olfram ResearchiMathematicat7.0

Setup type:
Install all components [recommended)

Selected components:
Wolfram Mathematica 7
Optional Components
4 athematica Motebook Indexers

Start Menu folder:
Wolfram Mathematica [v]

<Back |[ Instal |[ Cancel l
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7. Click Finish to complete the installation and launch Mathematica.

4% Wolfram Mathematica Setup g = [:J

Completing the Wolfram
Mathematica installation

‘wolfram Mathematica has been installed on your computer.

Click Finish ta exit.

Launch \Wolfram Mathematica

8. Mathematica starts up and the following password dialog box appears. Select Network
License. Then enter the name or IP address of the license server running MathLM in the
text field provided.

'8 personalize Mathematica @

Wolfram Mathematica’7

Flease parsonakze your copy of Mathematica

() Gngle Machine
4 password speckic to this machine wil be Hame
required, Please erter your name andfor
crganization and your kcense numbes, then Qroanization
cick OK to continue.
License Number
(=) Network License

ou vl cbtain a koense from a server on
your local rstweork sach time Mathematics is
laureched.

Erier the name of & server running a Mathematica lcense manager

e [ ox |

9. Click OK. You are now ready to start using Mathematica.

Installing Mathematica for Single-Machine Licenses

Follow these instructions to install a standalone copy of Mathematica that does not get a license
from a license server. Depending on your license type, this may require contacting Wolfram
Research to purchase additional licenses.
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To run Mathematica, you must register with Wolfram Research and receive a password. See
"Registration and Passwords" for further information.

To install Mathematica on Windows 2000/XP/Vista, you must have administrative privileges.
To Install a Single-Machine Copy of Mathematica on Windows:

1. Insert the Mathematica DVD. The Wolfram Mathematica 7 window appears on your
screen. Click the button labeled Install Mathematica to a hard disk.

%£ Wolfram Mathematica 7 E

Wolfram
Mathematica7

Install Mathematica
to a hard disk

© 1982-2008 Wolfram Research, Inc.

2. The Wolfram Mathematica Setup dialog appears on your screen. Click Next to begin
the installation process.

%ﬁ Wolfram Mathematica Setup g\ [} \

Wolfram Mathematica Setup

This will install ‘wolfram kMathematica 7 on your computer.

[ MNest> |[ Cancel
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3. By default, Mathematica is installed in the directory C:\Program Files\Wolfram Research)\
Mathematica\7.0. To choose another destination directory, click Browse. Click Next to
continue.

4% Wolfram Mathematica Setup g [m)

Destination Location
Where should Wolfram Mathematica be installed?

J Setup will install Wolfram Mathematica inta the following folder.

To continue, click Nest. If you would like to select a different folder, click Browse.

C:\Program Filestwoliram Researchih athematicas 7.0

At least 1,443.6 ME of free disk space is required.

[ < Back “ MNext > ][ Cancel ]

4. Mathematica is configured to automatically install all optional components. To chose
another configuration, de-select any components by clicking on the corresponding check-
box. Click Next to continue.

1€ Wolfram Mathematica Setup E] O

Select Components
‘Wwhich components should be installed?

Select the components you want to install; clear the components you do not want ta
install. Click Mext when you are ready to continue.

Optional Components 2.0MBE
Mathematica Notebook Indexers 2.0MB

Current selection requires at least 1,448.6 MB of disk space.

< Back ” Next » ][ Cancel
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5. Click Next to add Mathematica shortcuts to the Start menu under Wolfram Mathematica.

1€ Wolfram Mathematica Setup [;] [m| E

Start Menu Folder
‘where should Setup place the program's shortcuts?

. Setup will create the program's shortcuts in the following Start Menu folder.

To continue, click Next. [f you would like ta select a different folder. click Browse.

‘Wwolfram Mathematicd

[JDaon't create a Start Menu folder

[ < Back ” Next > ][ Cancel

6. Click Install to install Mathematica.

(o1
A€ Wolfram Mathematica Setup E] [m|
Ready to Install
Setup is now ready to begin installing \Wolfram Mathematica on your computer.
Click Install to continue with the installation, or click Back if you want to change any
settings.

Destination location:
C:\Program Files\wolfram Rezearchi\Mathematicat7.0

Setup type:
Install all components [recommended)

Selected components:
‘Walfram Mathematica 7
Optional Camponents
Mathematica Motebook Indexers

Start Menu folder:

‘Walfram Mathematica ‘ll

[ <Back || Instal |[ Cancel ]
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7. Click Finish to complete the installation and launch Mathematica.

€ Wolfram Mathematica Setup ugu

Completing the Wolfram
Mathematica installation

‘wolfram Mathematica has been installed on your computer.

Click Finish to exit.

8. Mathematica starts up and the following password dialog box appears. Select Single
Machine. Then enter your name, the name of your organization, and your license num-
ber (located on your electronic or printed license certificate) in the text fields provided.
Click OK when you are done.

1% Personalize Mathematica a

Wolfram Mathematica7

Please parsonakize your copy of Mathematica

@) Single Machine
A password specfic to ths machine wil be Hame

dlick O to continue.

O Metwork License

You vl cbitain 4 koense from a server on
your lacal retwork sach time Mathematica is
laurched.

Eriter the name of & server running & Mathematica losnse manager

™y x|
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9. The following dialog box appears showing the MathID number for your machine. To obtain
your password, click the Web button, go to register.wolfram.com, or contact Wolfram
Research (see "Registration and Passwords" for further information). You will need to
supply your license number and your MathID number.

H¢ Personalize Mathematica

Wolfram Mathematica7

The quickest and easiest way to obtain a password is to register
on the web, Click the Web button to open your browser and
register to obtain your password.

MathID  6102-07991-75515]

Password Web

NOTE: The information you provide when you register will only be
used at Wolfram Research. Your information will never be sold or
provided to anyone else.

Ger wers oReser

10. Enter your password and click OK. You are now ready to start using Mathematica.

One convenient way to install Mathematica is to run the installer remotely from a file server.
This is an efficient way of making Mathematica available to a large number of users without
having to supply a DVD to each one.

Installing Mathematica from a file server requires first copying the installer executable and all
files in the Mathematica distribution from the DVD onto the file server.

1. Insert the Mathematica DVD into the drive on the file server. Open a My Computer
window, then right-click the DVD in the list and select Open.

2. An Explorer window appears showing the contents of the DVD. Select the Windows folder.

3. Copy the Windows folder from the DVD to a location on the file server accessible to exter-
nal users over the network.

Once this step is complete, you can install the Mathematica files on each client.

4. From the client, connect to the file server and open the Windows directory that was cre-
ated on the file server.

5. Double-click the file Setup.exe to launch the installer.

6. Follow the same steps as for installing from a DVD (see "Network License" and "Single-
Machine License").



System Administration for Single-Machine Licenses | 109

Installing Mathematica from a Script

If you are installing Mathematica on multiple machines, it can be time-consuming to respond to
all of the installer prompts on each individual machine. By supplying command-line options to

the installer, you can customize various features of the installation process or automate it

entirely.

/dir="C: \path\here" specify the installation directory

DisableShellVerbs disable file associations for .m, .nb, .nbp, etc. (enabled by
default)

/group="start menu folder name" specify the start menu folder name

/noicons disable creation of start menu folder and shortcuts

/norestart do not restart the system, even if necessary

/restartexitcode=code specify the installer exit code to return if restart is
necessary

/silent force an automatic installation and suppress installation
windows

/suppressmsgboxes suppress installer message boxes (only effective when

used in conjuction with /silent)
Mathematica Installer supported command-line options.

To Create a Script That Performs a Silent Mathematica Installation:

The following instructions explain how to write a simple script to silently install Mathematica
from a file server. These instructions require that you have a mathpass file with a valid pass-
word. See "Registrations and Passwords" for more information on sitewide mathpass
configurations.

1. Follow the instructions in the first part of "Installing Mathematica from a File Server" to
copy the installer and files from the DVD to a file server.

2. Copy your mathpass file to the same directory on the file server as the installer and
Mathematica files.

3. Open Notepad (Start Menu » Programs » Accessories » Notepad) and type the follow-
ing lines into a new file.

@echo off

echo Installing Mathematica...

\\server\math\setup.exe /silent /suppressmsgboxes /log="C:\Windows\Temp\install.log"
echo Creating password file...

copy \\server\math\mathpass "C:\Directory\Name"

echo Mathematica installation complete.
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Change all instances of \\server\math to the pathname of the network share where the
Mathematica installation files and mathpass file were copied.

5. Change "C:\Directory\Name" to the directory listed here for your version of Windows.
Be sure to enclose the name of the directory in quotes.

Windows 2000/XP—
"C:\Documents and Settings\All Users\Application Data\Mathematica"

Windows Vista—"C:\ProgramData\Mathematica"

Note: These directories are the values of $BaseDirectory for different versions of
Windows. See "Configuration Files on Windows" for further information.

6. To save the file, choose File » Save. Save the file in the same directory as the Mathemat-
ica installation files. Type the filename install.bat, and choose All Files from the Save as
type popup menu. Click Save, then quit Notepad.

To Perform a Silent Mathematica Installation:

1. On the client, open a Command Prompt window, type the pathname of the install.bat
file, and press Enter. For example, if the network share is called \\server\math, type:

\\server\math\install.bat
The following messages are displayed.

Installing Mathematica...
Creating password file...
Mathematica installation complete.

2. The installation is now complete. If you see any messages other than those printed here,
check the file C:\Windows\Temp\install.log on the client machine for further information.

Installing Mathematica in this way eliminates the need to take the DVD to each client machine,

and saves time by allowing you to run a simple script instead of responding to the installer

questions.

Launching Mathematica on Windows

To run Mathematica using a network license, both the client machine and the license server
must be on the network, and MathLM must be running.
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To Launch Mathematica:
From the Start menu, choose Programs » Wolfram Mathematica » Mathematica 7.

Alternatively, you can open an Explorer window, go to the Program Files\Wolfram Research\
Mathematica\7.0 directory, and double-click the Mathematica icon.

To Launch Only the Mathematica Kernel:
From the Start menu, choose Programs » Wolfram Mathematica » Mathematica 7 Kernel.

Alternatively, you can open an Explorer window, go to the Program Files\Wolfram Research\
Mathematica\7.0 directory, and double-click the MathKernel icon.

To Launch the Mathematica Kernel inside a Command Prompt Window:

Open a command prompt window and change directory to the top-level Mathematica installa-

tion directory. Type .\math and press Enter.

You can also run Mathematica directly from a file server, without installing files locally. To do
this, install Mathematica on the file server and make the installation directory accessible to the
client machines. Running Mathematica from a file server differs from running a local copy in

several ways. These differences and appropriate steps for working around them are listed here.

m The Mathematica fonts will not be available for use by other applications. It is therefore
required that you manually install the fonts on your system. The fonts are found in
SystemFiles\Fonts\Windows in the Mathematica layout. To install these fonts so they can be
used by all other Windows applications, open the Fonts control panel, choose Install New
Font under the File menu, and specify the location of the fonts in the Add Fonts dialog
box that appears.

m The MathLink libraries will not be available for use by other applications. Therefore, you
need to copy the MathLink libraries to the appropriate locations on your system. For 32-bit
Windows systems, the MathLink libraries consist of seven files: mi32il.dll, miI32i2.dll,
mi32i3.dll, mimap32.mlp, mishm32.mlp, mltcp32.mlp, and mltcpip32.mip, which are
located in SystemFiles\Links\MathLink\DeveloperKit\Windows\SystemAdditions in the
Mathematica layout. Copy these files to the WINNT\System32 folder on Windows 2000, or
the Windows\System32 folder on Windows XP/Vista. For 64-bit Windows platforms, the
MathLink libraries consist of twelve files: mi32il.dll, mi32i2.dll, mI32i3.dll, mimap32.mlp,
mlshm32.mlp, mltcp32.mlip, and mltcpip32.mlp, which are located in
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SystemFiles\Links\MathLink\DeveloperKit\Windows\SystemAdditions, and ml64i2.dll,
ml64i3.dll, mishm64.mlp, mltcp64.mlp, mltcpip64.mlp, which are located in
SystemFiles\Links\MathLink\DeveloperKit\Windows-x86-64\SystemAdditions. Copy the first
seven files to the Windows\Syswow64 folder and the other five files to the Windows\
System32 folder.

m The proper file associations will not be set up for Mathematica. You can set these associa-
tions manually by using the Folder Options dialog box under the Tools menu of the
Explorer window. You will need to specify the MIME type as application/mathematica and
the file extension as .nb.

= A Start menu entry for Mathematica will not be created automatically. You can add this
manually by editing the Start menu settings in the dialog box that appears when you
choose Settings » Taskbar and Start Menu under the Start menu.

Following are several useful command-line options for the Mathematica kernel. See "Launching

Mathematica on Windows: Locally" for instructions on running the kernel.

Command-Line Options

-lmverbose print diagnostic information to stderr

-mathlink specify that the kernel should be run in MathLink mode

-noprompt specify that no banner or In/Out prompts should be printed

-password str specify a password to use instead of the password or
passwords stored in the mathpass file

-pwfile file specify the name of a file that has a valid password

-run specify a command to be run on startup as an argument

Mathematica command-line options.

The option -1mverbose is usefull for debuggin problems related to the license server.

The option -mathlink can also be used as a command-line option for the Mathematica front

end. See www.wolfram.com/solutions/mathlink for additional information about MathLink.
The mode set by -noprompt is useful for running a sequence of commands from a batch file.

The string for -password should have the form "/servername" or "machinename mathid licensenumber

password" .
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Testing the Installation on Windows

The following simple commands allow you to test the installation of Mathematica. Running
these commands does not guarantee that the installation was successful, but a failed command

can indicate that a serious problem occurred during installation.

You should run these tests from a regular user account and not from an account with administra-

tive privileges.

To run Mathematica using a network license, both the client machine and the license server

must be on the network and MathLM must be running.

If you run into problems when doing these tests, see the troubleshooting tips in "Trouble-
shooting on Windows". If you do not find the answer there, check the Technical Support web-
site at support.wolfram.com/mathematica.

1. To start the kernel, choose Programs » Wolfram Mathematica » Mathematica 7
Kernel from the Start menu.

In[l]:=

2. Type N[Pi, 20] and press Enter. The number in the output should match the output

shown here.
In[l]:= N[Pi, 20]
Out[l]= 3.1415926535897932385

In[2]:

3. To exit the kernel, type Exit and press Enter.

1. Launch Mathematica by choosing Programs » Wolfram Mathematica » Mathematica
7 from the Start menu.

A splash screen with initialization information appears briefly, after which an empty note-
book and the Welcome Screen appear.

2. Type N[Pi,20]. Then hold down the Shift key and press Enter to evaluate. This should
send the command to the kernel and return the same result as before. The In[1] and
out[ 1] labels are prepended once the evaluation is completed.
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In the notebook window, there should be a horizontal line across the notebook; this is the
horizontal insertion bar. If you do not see one, move the pointer until it becomes a horizon-
tal I-beam and click once to see the insertion bar.

3. Press the Esc key. You should see three small horizontal lines in a column (). Type int
and press Esc again. You should see an integral sign (f). As an additional font check,
typing \[CheckmarkedBox] and \[CirclePlus] should print the symbols & and ¢,
respectively. If the symbols show up correctly, the fonts have been properly installed.

4. From the Help menu, choose Documentation Center. The Mathematica Documentation
Center should appear.

Configuration Files on Windows

Mathematica stores preference settings and initialization data in two directories,
$BaseDirectory and $UserBaseDirectory. Within each of these directories are several possi-

ble subdirectories with titles such as FrontEnd, Kernel, and Licensing.

Global settings that affect all users are stored in subdirectories of the directory
$BaseDirectory. The default value of $BaseDirectory for different versions of Windows is
shown in the following table. To redefine the location of global preference settings and initializa-
tion data, set the environment variable MATHEMATICA_BASE.

Windows 2000/XP C:\Documents and Settings\All Users\Application Data\Mathematica
Windows Vista  C:\ProgramData\Mathematica

Location of the directory $BaseDirectory for different versions of Windows.

Settings that only affect a particular user are stored in subdirectories of the directory
$UserBaseDirectory. The default value of $UserBaseDirectory for different versions of Win-
dows is shown in the following table. To redefine the location of user preferences and initializa-
tion data, set the environment variable MATHEMATICA_USERBASE.

Windows 2000/XP  C:\Documents and Settings\username\Application Data\Mathematica
Windows Vista  C:\Users\username\AppData\Roaming\Mathematica

Location of the directory $UserBaseDirectory for different versions of Windows.

Settings in the directory sUserBaseDirectory override global settings defined in the directory

$BaseDirectory.
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In the pathnames that follow, replace the variables $BaseDirectory and $UserBaseDirectory
with the appropriate directories for your system. To find their locations on your system, evalu-

ate the command s$BaseDirectory (Or $UserBaseDirectory) in a Mathematica notebook.

The initialization files used by the kernel contain Mathematica commands that are evaluated at
startup, such as function definitions, packages to load, and kernel option settings. These com-

mands are also available to the Mathematica front end.
$BaseDirectory\Kernel\init.m

This file is used to initialize the kernel and therefore should store any kernel commands
that are appropriate for all users running the kernel.

$UserBaseDirectory\Kernel\init.m

This file stores user-specific commands used to initialize the kernel.

Kernel initialization files are not created automatically.

Front end initialization files store preference settings such as the values of global options in the
Option Inspector. These files are automatically updated by Mathematica when you change a
setting in the front end. To make changes to this file, make your changes from within Mathemat-

ica rather than editing the file directly.
$BaseDirectory\FrontEnd\init.m

This file stores systemwide defaults used by all Mathematica front ends. The settings in
this file affect all users. "Systemwide Defaults on Windows" explains how to implement
changes to this global file.

$UserBaseDirectory\FrontEnd\init.m

This file defines settings within the front end that are specific to each user.

Front end initialization files are created automatically.

The front end stores certain information about system settings in caches specific to each user.

The default location for front end caches is shown here.
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Windows 2000/XP  C:\Documents and Settings\username\Local Settings\
Application Data\Mathematica\FrontEnd\7.0 Caches

Windows Vista  C:\Users\username\AppData\Local\Mathematica\FrontEnd\7.0 Caches

Location of the front end caches for different versions of Windows.

Passwords are stored in the mathpass file, described in further detail in "Registration and Pass-
words". In the following pathname, replace the variable $InstallationDirectory with the
directory where you installed Mathematica. The default value of $InstallationDirectory on
Windows is C:\Program Files\Wolfram Research\Mathematica\7.0. To find the value of
SInstallationDirectory on your system, evaluate the command $InstallationDirectory
in @ Mathematica notebook.

$BaseDirectory\Licensing\mathpass

This is the default location for the global password file.
$InstallationDirectory\Configuration\Licensing\mathpass
This is an alternative location for the global password file.
$UserBaseDirectory\Licensing\mathpass

While this is not normally the location for the password file, a user-specific mathpass file
can be stored here.

Systemwide Defaults on Windows

If you have installed Mathematica in a location where multiple users can run it (for example, on
a file server or multi-user machine), then you can set up systemwide defaults for the Mathemat-
ica front end and kernel. This is ideal for setting up Mathematica for use in computer labs and
classrooms. If you share the directory $BaseDirectory across the network, these defaults will

also take effect on local installations that use the shared $BaseDirectory.

In the pathnames that follow, replace the variables $BaseDirectory and
SUserBaseDirectory with the appropriate directories for your system. To find their locations
on your system, evaluate the command $BaseDirectory (or S$UserBaseDirectory) in a
Mathematica notebook.
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1. Launch Mathematica, and set up any changes to the front end that you need. For exam-
ple, you may want to modify default file locations, language options, or menu settings.

2. Quit Mathematica.

3. Copy the file SUserBaseDirectory\FrontEnd\init.m to the directory $BaseDirectory)\
FrontEnd.
These settings will now be used by the front end unless overridden by the local init.m file stored

in the user’s $UserBaseDirectory\FrontEnd directory.

1. Launch Mathematica, and create a new file.

2. Add any Mathematica commands that should be evaluated on startup. For example, you
may want to add a function definition or display a message at startup. Enter all the com-
mands in the same cell, separating commands with semicolons.

3. Make this cell an initialization cell by selecting the cell bracket and then choosing Cell »
Cell Properties » Initialization Cell.

4. When you have finished making your changes, choose File » Save and select Mathemat-
ica Package from the Save as type popup menu. Then save the file as
$BaseDirectory\Kernel\init.m.

These commands will be evaluated when users launch Mathematica. If you added a function
definition, that function will be available to all users.

If you have created systemwide defaults you want to carry over to new local installations, you
can add lines to an installation script to copy preconfigured init.m files as part of a new installa-
tion. For information about installation scripts, see "Installing Mathematica on Windows". To
copy systemwide defaults, add a line to the script similar to the line that copies the mathpass

file.

Troubleshooting on Windows

If the front end password dialog box appears when you launch Mathematica, either Mathemat-

ica could not locate the mathpass file or there was no valid password in the mathpass file.
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To resolve this problem, first check that there is a mathpass file in one of these
directories: $BaseDirectory\lLicensing, $InstallationDirectory\Configuration\Licensing, or
$UserBaseDirectory\Licensing. To find the exact location of these directories on vyour
machine, evaluate the command $BaseDirectory (or S$InstallationDirectory oOr
SUserBaseDirectory) in a notebook. If you did not find a mathpass file in these locations,

follow the instructions in "Entering a Single-Machine Password" to reenter your password.

If there is a mathpass file in one of those directories, the password or passwords are invalid.
Make sure that your MathID number matches the MathID number used to issue your password.
If your MathID number changes, you will need to contact Customer Service to get a new pass-

word. Contact information is provided in "Registration and Passwords".

Front end preferences, such as the locations of recently opened and saved files, are stored in a
front end initialization file called init.m. This file is located in $UserBaseDirectory\FrontEnd.
The default value of $UserBaseDirectory for different versions of Windows is listed in
"Configuration Files on Windows". To find the exact location of this directory on your machine,

evaluate the command $UserBaseDirectory in a notebook.

If you need to reset the front end preferences to their default values, hold down Shift+Ctrl
during startup. This will cause the initialization file to be rebuilt automatically.

Information about your Mathematica system layout, such as the locations of text resource files,
is stored in caches. These caches are located in C:\Documents and Settings\username\Local
Settings\Application Data\Mathematica\FrontEnd\7.0 Caches\ on Windows 2000/XP and in
C:\Users\username\AppData\Local\Mathematica\FrontEnd\7.0 Caches\ on Vista.

A corrupted cache may cause the front end to produce an error or quit immediately on startup.
The most convenient way to restore the caches to their default values is to hold down
Shift+Ctrl during startup. This will cause the Mathematica caches and the initialization file to be
rebuilt automatically. If you want to rebuild your caches but retain your preferences, hold down
Shift during startup. This will delete and rebuild the cache without rebuilding your front end
initialization file.
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For further assistance, check the Technical Support FAQs on the web at support.wolfram.com.
If you are a Site License Administrator, additional Site License Documentation is available at
site.wolfram.com. If you do not find the information you need, please contact Technical Support
by sending email to support@wolfram.com or by calling +1-217-398-6500. Include your license
number in all correspondence. Your license number is located on your electronic or physical
copy of the license certificate. It is also available after installation by going to the Help menu
and clicking About Mathematica. You must be a registered user in order to receive installation

support. You must have a current Premier Service subscription to receive Technical Support.

Unix and Linux

Installing Mathematica on Unix and Linux

Requirements

Mathematica is available for Windows, Unix, Linux, and Mac OS X. For a complete list of plat-
form availability, visit www.wolfram.com/products/mathematica/platforms.html. Any supported
machine can act as a client for running Mathematica, provided the following two conditions are
met:

m The client has access to the Mathematica files, either locally or from a file server on the
network.

m The license server running MathLM is available on the TCP/IP network.

A license server can also function as its own client. However, this is not recommended. If the
machine has to be rebooted for any reason, the serving of licenses to all other clients on the
network may be disrupted.

Before you install Mathematica as a license server client, MathLM should already be installed
and running on a license server on the network (see "Installing MathLM on Windows", and
"Installing MathLM on Unix, Linux, and Mac OS X" for details). To complete the Mathematica
installation, you will need to know the name or IP address of the license server running MathLM.

To install Mathematica on Unix and Linux, you may need root privileges.
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To Install Mathematica:

1.

Mount the CD or DVD. For information on mounting a CD/DVD, see "Mounting a CD or
DVD on Unix and Linux".

Note: This step may not be required on some Linux and Unix platforms, as some operat-
ing systems automatically handle mounting.

Change directory to /cdrom/Unix/Installer. Note that the exact location of the CD/DVD
mount point might be different for your platform.

cd /cdrom/Unix/Installer

Run the installer.

./MathInstaller

Copyright (c) 1988-2008 Wolfram Research, Inc. All rights reserved.

WARNING: Wolfram Mathematica is protected by copyright law and
international treaties. Unauthorized reproduction or distribution may
result in severe civil and criminal penalties and will be prosecuted to
the maximum extent possible under law.

(Unix only) You are asked to select the platforms for which you are doing the installation.
Select one or more of the available options and press Enter to continue.

For which of the following platforms would you like to install
Mathematica?

Type your selection (multiple choices can be separated with spaces), or
press
ENTER to select (1l):

The installer prompts you to specify the directory in which Mathematica should be in-
stalled. The default location is /usr/local/Wolfram/Mathematica/7.0. Press Enter to
accept the default, or type in a new location and then press Enter.

Enter the installation directory, or press ENTER to select
/usr/local/Wolfram/Mathematica/7.0:

Note: If you specify a directory that does not exist, the installer will give you the option
of creating the directory. If a copy of Mathematica already exists in the directory you
specify, the installer will inform you before overwriting the files.
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Note: If you are installing over a previous version of Mathematica, your existing math-
pass file and custom settings will not be deleted.

Once you have answered all the questions, the installer begins copying files from the
CD/DVD to the directory you specified. The progress is indicated by a progress bar on the
screen.

Now installing...

[*************** ]

You are asked for the location in which to copy the executable scripts. You should choose
a directory that is present on each user’s PATH. The scripts are also installed in the Exe-
cutables subdirectory of the Mathematica installation directory. Type a location or accept
the default and press Enter.

Type the directory path in which the Mathematica scripts will be created,
or press ENTER to select /usr/local/bin:

Note: The installer checks to see if any other Mathematica scripts exist in the specified
directory. If they do, you are given the chance to rename the scripts.

You are given several options for configuring the password. Type 2 and press Enter to run
Mathematica using a network license.

Please choose how you want to configure the password for Mathematica 7.0.

(1) Single machine
Install a password specific to this machine. Mathematica will launch
and you can enter your password.

(2) Network license
Obtain a license from a MathLM license server on your network each time
Mathematica is launched.

(3) Enter license information later
Input your password and register when you start Mathematica.

Type your selection, or press ENTER to select (1):2

Type the hostname of the server running MathLM, as given by the hostname command.
In some cases, this includes the domain name. Or, enter the IP address of the MathLM
server. Press Enter to continue.

Enter the hostname of the machine on which your MathLM license manager
is running:
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Note: The installer does not attempt to verify the server name you type. If you prefer,
you may type any arbitrary text here and press Enter. This creates the mathpass file with
an invalid password entry. You may then edit the mathpass file manually to add a correct
password later. More information on the mathpass file is given in "Registration and
Passwords".

10. The installer creates the mathpass file and displays its location. The installation is now
complete.

Configuring Network Password...
Adding password file entry to /usr/share/Mathematica/Licensing/mathpass...

Installation complete.

The installer also adds an additional menu folder named Wolfram to the desktop menu. Inside
the folder is an item named Mathematica that points to the most recently installed version of
Mathematica. File associations are also modified such that .nb files are now associated with the

most recently installed version of Mathematica.

Follow these instructions to install a standalone copy of Mathematica that does not get a license
from the license server. Depending on your license type, this may require contacting Wolfram

Research to purchase additional licenses.

To run Mathematica, you must register with Wolfram Research and receive a password. See

"Registration and Passwords" for further information.
To install Mathematica on Unix and Linux, you may need root privileges.
To Install a Single-Machine Copy of Mathematica on Unix and Linux:

1. Mount the CD or DVD. For information on mounting a CD/DVD, see "Mounting a CD or
DVD on Unix and Linux".

Note: This step may not be required on some Linux and Unix platforms, as some operat-
ing systems automatically handle mounting.

2. Change directory to /cdrom/Unix/Installer. Note that the exact location of the CD/DVD
mount point might be different for your platform.

cd /cdrom/Unix/Installer
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Run the installer.

./MathInstaller

Copyright (c) 1988-2008 Wolfram Research, Inc. All rights reserved.

WARNING: Wolfram Mathematica is protected by copyright law and
international treaties. Unauthorized reproduction or distribution may
result in severe civil and criminal penalties and will be prosecuted to
the maximum extent possible under law.

(Unix only) You are asked to select the platform for which you are doing the installation.
Select one of the available options and press Enter to continue.

For which of the following platforms would you like to install
Mathematica?

Type your selection (multiple choices can be separated with spaces), or
press
ENTER to select (1l):

The installer prompts you to specify the directory in which Mathematica should be in-
stalled. The default location is /usr/local/Wolfram/Mathematica/7.0. Press Enter to
accept the default, or type in a new location and then press Enter.

Enter the installation directory, or press ENTER to select
/usr/local/Wolfram/Mathematica/7.0:

Note: If you specify a directory that does not exist, the installer will give you the option
of creating the directory. If a copy of Mathematica already exists in the directory you
specify, the installer will inform you before overwriting the files.

Note: If you are installing over a previous version of Mathematica, your existing math-
pass file and custom settings will not be deleted.

Once you have answered all the questions, the installer begins copying files from the
CD/DVD to the directory you specified. The progress is indicated by a progress bar on the
screen.

Now installing...
[*************** ]
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7.

9.

You are asked for the location in which to copy the executable scripts. You should choose
a directory that is present on each user’'s PATH. The scripts are also installed in the Exe-
cutables subdirectory of the Mathematica installation directory. Type a location or accept
the default and press Enter.

Type the directory path in which the Mathematica scripts will be created,
or press ENTER to select /usr/local/bin:

Note: The installer checks to see if any other Mathematica scripts exist in the specified
directory. If they do, you are given the chance to rename the scripts.

You are given several options for configuring the password. Type 1 and press Enter to run
Mathematica using a single-machine license.

Please choose how you want to configure the password for Mathematica 7.0.

(1) Single machine
Install a password specific to this machine. Mathematica will launch
and you can enter your password.

(2) Network license
Obtain a license from a MathLM License Server on your network each
time Mathematica is launched.

(3) Enter license information later
Input your password and register when you start Mathematica.

Type your selection, or press ENTER to select (1):1

Your machine name and MathID number are displayed. To obtain your password, contact
Wolfram Research (see "Registration and Passwords" for details). You will need to supply
your MathID number and the license number located on your electronic or physical copy
of the license certificate.

Configuring Single-Machine Password...

Mathematica 7.0 for operating system
Copyright 1988-2008 Wolfram Research, Inc.

You will need to get a password from your
license certificate or from Wolfram Research
(register.wolfram.com).

Machine name: hostname

MathID: XXXX—-XXXXX-XXXXX
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You will need a valid license ID and password in order
to proceed. Go to http://register.wolfram.com or
http://reference.wolfram.com/singlemachine for more
information.

10. Enter your name, the name of your organization, your license number (located on your
electronic or physical copy of the license certificate), and your password, and press Enter
when you are done.

Enter your name:
Enter the name of your organization:
Enter your license ID [format LXXXX-XXXX]:

Enter your password:

11. The installer creates the mathpass file and displays its location. The installation is now
complete.

Creating password file entry in
/usr/share/Mathematica/Licensing/mathpass.

See http://reference.wolfram.com/password if

Mathematica is installed on multiple machines

and you need to set up a single, sitewide

password file.
The installer also adds an additional menu folder named Wolfram to the desktop menu. Inside
the folder is an item named Mathematica that points to the most recently installed version of
Mathematica. File associations are also modified such that .nb files are now associated with the

most recently installed version of Mathematica.

One convenient way to install Mathematica on a client is to run the installer remotely from a file
server. This is an efficient way of making Mathematica available to a large number of users
without having to supply a CD/DVD to each one. You can install Mathematica from a file server
on a client running any supported Unix or Linux platform. It is not necessary that the client
platform be the same as the file server platform.
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To install Mathematica from a file server, you first must make the installer and Mathematica
files available to the clients. You can do this by copying the contents of the CD/DVD to the file
server and exporting the directory, or by exporting the CD/DVD mount point on the file server.
Then, mount the directory with the Mathematica distribution on the client and change to this
directory, and run MathInstaller to install Mathematica on the client machines. (Note that
you must run MathInstaller from the directory in which it is located.) If you are installing
Mathematica in a mixed-platform environment, you may need to use the MathInstaller

option -platform to ensure that the correct files for your platform are installed.

If you are installing Mathematica on multiple machines, it can be time-consuming to respond to
all of the installer prompts on each individual machine. By supplying command-line options to
the MathInstaller command, you can customize various features of the installation process

or automate it entirely.

-auto force the installation to proceed automatically without
prompting the user for any information

-createdir=value specify whether or not to create the directories specified by
the options -targetdir and -execdir

-execdir=dir specify the path to be used for the symbolic links to the
executable scripts

-help display information about the installer options

-method=type define the type of installation you would like to perform

-overwrite=value specify whether the installer should overwrite any files that

already exist in the target directory

-platforms=value specify the system ID of the Unix platform or platforms
(e.g., Linux, Solaris, and so forth) for which you want to
do the installation

-selinux=value specify whether the installer should attempt to modify the
security context of any included libraries so that it will
function properly

-silent force an automatic installation (equivalent to the -auto
option)

-targetdir=dir specify the installation directory

-verbose display detailed information about the files and directories

being installed

MathInstaller command-line options.
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Note: Default values are used for any options that are not specified explicitly on the
command line.

Valid input for -createdir is y for yes or n for no. By default, this value is set to y.

The default directory for —execdir is /usr/local/bin. This option only works with an auto-

matic installation.

The values for -method may vary by product. When this option is applicable, the values can be
determined by running the installer. The default value for this option is Full.

Valid input for —overwrite is y for yes or n for no. By default, this value is set to y. This option
only works with an automatic installation.

The default for -platforms is the system you are installing on, if that information is available

to the installer. This option only works with an automatic installation.
Valid input for -selinux is y for yes or n for no. By default, this value is set to n.

The option -silent suppresses any output from being displayed on the screen. The output is
instead written to a file named InstallerLog-number. If the installation is unsuccessful, the log
file is saved in the /tmp directory. Otherwise, the file is moved to the target directory and
renamed InstallerLog.

The directory specified for -targetdir corresponds to the value of the global variable
$InstallationDirectory. The default value is /usr/local/Wolfram/Mathematica/7.0.

This option only works with an automatic installation.
To complete the installation in one step, run a command like the following.

./MathInstaller -auto -targetdir=/home/mathematica

This allows you to complete the installation automatically in one step, while still being able to
customize various details such as the directory to install to. You are not prompted to enter your
password using this method, so you will need to enter a password the first time Mathematica is
launched.

If you are doing many installations, you might find it convenient to include the MathInstaller
command with all the relevant options in a shell script. Running the shell script is then an easy
way to do an identical customized installation on multiple machines. You can further simplify

the installation process by including a line in your script that copies an existing mathpass file to
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the appropriate location on the newly installed machine. Note that MathInstaller must be run
from the directory in which it is located, so your script may require a command to change
directory. See "Registrations and Passwords" for information on sitewide mathpass

configurations.

Launching Mathematica on Unix and Linux

To run Mathematica using a network license, both the client machine and the license server
must be on the network and MathLM must be running.

To Launch Mathematica:
Make sure that you are running MathLM. Then, from a shell, type mathematica and press Enter.

Alternatively, if you are running X, an additional menu folder named Wolfram has already been
added to the desktop menu. In the folder, an item named Mathematica points to the most
recently installed version of Mathematica. File associations have also been modified such that

.nb files now associate with the most recently installed version of Mathematica.

To Launch Only the Mathematica Kernel:

From a shell, type math and press Enter.

Rather than installing Mathematica on every client machine, you can install Mathematica on a
file server and export the installation directory to the clients. To display the front end, the
clients must have access to the Mathematica fonts. For information about configuring the X
server on the client machines to find the Mathematica fonts, see "Fonts on Unix and Linux".
Once the fonts are properly configured, the client machines can run Mathematica as though it

were a local installation.

The math command starts the kernel from within a shell. The kernel is the part of Mathematica

that handles calculations. This is also used by the front end.
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Command-Line Options

-initfile file specify the name of a file containing startup commands

-lmverbose print diagnostic information to stderr

-mathlink specify that the kernel should be run in MathLink mode

-noinit specify that no initialization file should be read at startup

-password str specify a password to use instead of the password or
passwords stored in the mathpass file

-pwfile file specify the name of a file that has a valid password

-run specify a command to be run on startup as an argument

math command-line options.

The option -1mverbose is usefull for debuggin problems related to the license server.

The option -mathlink can also be used as a command-line option for the Mathematica front

end. See www.wolfram.com/solutions/mathlink for additional information about MathLink.

The string for -password should have the form "Iservername" or "machinename mathid licensenumber

password".

The mathematica command runs the X front end. In order for the front end to run, the DIs-
PLAY environment variable must be set and the front end must be able to locate the fonts
included with Mathematica.

-backgroundTaskDelay n specify the time (in milliseconds) that the front end delays
background tasks while waiting for input

-cleanStart ignore stored caches and rebuild the front end preferences
file

-copyright display copyright information on the command line

-dontUpdatePrefs prevent changes to the user's preference settings

-font f specify the font used in menus, buttons, etc.

-help display a list of all command-line options

-lmverbose print diagnostic information to stderr when connecting to

MathLM
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-mathlink make the front end run as a child process that is capable of
accepting MathLink packets
-nogui prevent the display of any kind of window or dialogs
-noSplashScreen prevent the splash screen from being displayed on startup
-noTrueTypeFont prevent the use of TrueType font in the display
-preferencesDirectory dir specify the location where preference settings are stored
-primaryModifierMask mask specify the primary mask to be used as the command key
-pwfile file specify a file in which to look for Mathematica passwords
-pwpath p specify the search path for a password file
-secondaryModifierMask mask specify the secondary mask to be used as the command
key
-singleLaunch allow only one copy of the front end per display
-stderrWindow send stderr to a popup window instead of a terminal
-style s specify the widget style used by the front end
-topDirectory dir specify the location of the Mathematica installation direc-
tory
-version print the current version of the front end on the command
line

mathematica command-line options.

The default for -backgroundTaskDelay is 100 milliseconds.

The option -cleanStart will ignore the caches stored in the directory
$UserBaseDirectory/FrontEnd/7.0_Caches, and will rebuild the front end preferences

file, $UserBaseDirectory/FrontEnd/init.m. This option can also be abbreviated as

-clean.

When using -font, a list of possible font names can be found by using xfontsel. The name
can be expressed either as an X Logical Font Description or as a valid font alias.

The option -1mverbose is useful for debugging problems related to the license server.

The option -mathlink may be useful when the front end is used as a typesetting or graphics
rendering service. See www.wolfram.com/solutions/mathlink for additional information about
MathLink.

The default directory for -preferencesDirectory is ~/.Mathematica.

The option -singleLaunch will prohibit multiple front end launches only if the current front end

was launched with the -singleLaunch option.
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Valid styles for -style are motif, motifplus, windows, cde, platinum, sgi, and compact.

The defaut location for -topDirectory is /usr/local/Wolfram/Mathematica/7.0.

Testing the Installation on Unix and Linux

The following simple commands allow you to test the installation of Mathematica. Running
these commands does not guarantee that the installation was successful, but a failed command
can indicate that a serious problem occurred during installation.

You should run these tests from a regular user account and not from an account with administra-
tor privileges.

To run Mathematica using a network license, both the client machine and the license server
must be on the network and MathLM must be running.

If you run into problems when doing these tests, see the troubleshooting tips in
"Troubleshooting on Unix and Linux". If you do not find the answer there, check the Technical
Support website at support.wolfram.com/mathematica.

1. To start the kernel, type math in a shell and press Enter.
In[1l]:=

2. Type N[Pi, 20] and press Enter. The number in the output should match the output
shown here.

In[l]:= N[Pi, 20]

Out[1l]= 3.1415926535897932385

In[2]:

3. To exit the kernel, type Exit and press Enter.

On Unix and Linux, you can test the kernel on a remote machine by using the command ssh
hostname /usr/local/bin/math. (The exact pathname could be different depending on how
Mathematica was installed.) This command will launch the kernel on the remote machine host-

name. When you see the In[1] label, follow step 2 and step 3 in the previous instructions.

1. Make sure that you are running X. Launch Mathematica by typing mathematica in a shell
and pressing Enter.
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Alternatively, you can select Mathematica from the menu folder Wolfram.

A splash screen with initialization information appears briefly, after which an empty note-
book and the Welcome Screen appear.

2. Type N[Pi,20]. Then hold down the Shift key and press Enter to evaluate. This should
send the command to the kernel and return the same result as before. The In[1] and
out[ 1] labels are prepended once the evaluation is completed.

In the notebook window, there should be a horizontal line across the notebook; this is the
horizontal insertion bar. If you do not see one, move the pointer until it becomes a horizon-
tal I-beam and click once to see the insertion bar.

3. Press the Esc key. You should see three small horizontal lines in a column (). Type int
and press Esc again. You should see an integral sign (f). As an additional font check,
typing \[CheckmarkedBox] and \[CirclePlus] should print the symbols & and ¢,
respectively. If the symbols show up correctly, the fonts have been properly installed.

4. From the Help menu, choose Documentation Center. The Mathematica Documentation
Center should appear.

On Unix and Linux, you can test the X front end remotely, provided the ssh server on the

remote machine allows X forwarding. You must be running X on the local machine to do this. In

a shell, type ssh -X hostname /usr/local/bin/mathematica. (The exact pathname could be

different depending on how Mathematica was installed.) This command will launch Mathematica

on the remote machine hostname. When the splash screen appears on your screen, follow step 2

and step 3 in the previous instructions.

Configuration Files on Unix and Linux

Mathematica stores preference settings and initialization data in two directories,
$BaseDirectory and $UserBaseDirectory. Within each of these directories are several possi-

ble subdirectories with titles such as FrontEnd, Kernel, and Licensing.

m Global settings that affect all users are stored in subdirectories of the directory
$BaseDirectory. The default value of $BaseDirectory on Unix and Linux is
/usr/share/Mathematica. To redefine the location of global preference settings and
initialization data, set the environment variable MATHEMATICA_BASE.

m Settings that only affect a particular user are stored in subdirectories of the directory
$UserBaseDirectory, wWhich is typically a subdirectory of the user’s home directory. The
default value of $UserBaseDirectory on Unix and Linux is ~/.Mathematica. To redefine
the location of user preferences and initialization data, set the environment variable
MATHEMATICA_USERBASE.
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Settings in the directory $UserBaseDirectory override global settings defined in the directory

$BaseDirectory.

In the pathnames that follow, replace the variables $BaseDirectory and $UserBaseDirectory
with the appropriate directories for your system. To find their locations on your system, evalu-

ate the command $BaseDirectory (Or $UserBaseDirectory) in @ Mathematica notebook.

The initialization files used by the kernel contain Mathematica commands that are evaluated at
startup, such as function definitions, packages to load, or kernel option settings. These com-

mands are also available to the Mathematica front end.
$BaseDirectory/Kernel/init.m

This file is used to initialize the kernel and therefore should store any kernel commands
that are appropriate for all users running the kernel.

SUserBaseDirectory/Kernel/init.m
This file stores user-specific commands used to initialize the kernel.

Kernel initialization files are not created automatically.

Front end initialization files store preference settings such as the values of global options in the
Option Inspector. These files are automatically updated by Mathematica when you change a
setting in the front end. To make changes to this file, make your changes from within Mathemat-

ica rather than editing the file directly.
$BaseDirectory/FrontEnd/init.m

This file stores systemwide defaults used by all Mathematica front ends. The settings in
this file affect all users. "Systemwide Defaults on Unix and Linux" explains how to imple-
ment changes to this global file.

SUserBaseDirectory/FrontEnd/init.m
This file defines settings within the front end that are specific to each user.
S$UserBaseDirectory/FrontEnd/7.0 Caches/

This directory within the user’s home directory stores information on system settings that
are read by the front end.

Front end initialization files are created automatically.
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Passwords are stored in the mathpass file, described in further detail in "Registration and
Passwords". In the following pathname, replace the variable $InstallationDirectory with the
directory where you installed Mathematica. The default value of $InstallationDirectory on
Unix and Linux is /usr/local/Wolfram/Mathematica/7.0. To find the value of
$InstallationDirectory on your system, evaluate the command $InstallationDirectory
in a Mathematica notebook.

$BaseDirectory/Licensing/mathpass

This is the default location for the global password file.
$InstallationDirectory/Configuration/Licensing/mathpass
This is an alternative location for the global password file.
SUserBaseDirectory/Licensing/mathpass

While this is not normally the location for the password file, a user-specific mathpass file
can be stored here.

Systemwide Defaults on Unix and Linux

If you have installed Mathematica in a location where multiple users run it (for example, on a
file server or multi-user machine), then you can set up systemwide defaults for the Mathemat-
ica front end and kernel. This is ideal for setting up Mathematica for use in computer labs and
classrooms. If you share the directory $BaseDirectory across the network, these defaults will

also take effect on local installations that use the shared $BaseDirectory.

The following instructions assume that $BaseDirectory and $UserBaseDirectory have their

default values, /usr/share/Mathematica and ~/.Mathematica respectively.

1. Launch Mathematica, and set up any changes to the front end that you need. For exam-
ple, you may want to modify default file locations, language options, or menu settings.

2. Quit Mathematica.

3. Copy the file ~/.Mathematica/FrontEnd/init.m to the directory /usr/share/
Mathematica/FrontEnd.
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These settings will now be used by the front end unless overridden by the local init.m file stored

in the user’s directory ~/.Mathematica/FrontEnd.

1. Launch Mathematica, and create a new file.

2. Add any Mathematica commands that should be evaluated on startup. For example, you
may want to add a function definition or display a message at startup. Enter all the com-
mands in the same cell, separating commands with semicolons.

3. Make this cell an initialization cell by selecting the cell bracket and then choosing Cell »
Cell Properties » Initialization Cell.

4. When you have finished making your changes, choose File » Save and select
Mathematica Package from the Save as type popup menu. Then save the file as
/usr/share/Mathematica/Kernel/init.m.

These commands will be evaluated when users launch Mathematica. If you added a function

definition, that function will be available to all users.

Fonts on Unix and Linux

Dealing with fonts under Unix and Linux can sometimes be tricky. The important issues in
dealing with fonts in Mathematica are presented here for your convenience.

The Mathematica front end supports BDF, TrueType, and Typel fonts. These fonts are automati-
cally installed by MathInstaller during installation.

All machines that display the front end must have access to the fonts included with Mathemat-
ica. If the Mathematica process is running on a remote machine and the front end is displayed
on the local machine, the X server on the local machine must know where to find the Mathemat-
ica fonts. To do this, add the Mathematica fonts to the local font path by running a command
like the following on the local machine.
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xset fp+ /usr/local/Wolfram/Mathematica/7.0/SystemFiles/Fonts/Typel; xset fp

rehash
Be sure to execute xset fp rehash to make the fonts available to the local X server.

For optimal onscreen performance, Typel fonts should appear before BDF fonts in the font
path. Hence, $InstallationDirectory/SystemFiles/Fonts/Typel should appear before
$InstallationDirectory/SystemFiles/Fonts/BDF. You can check the order of the font
path by executing the command xset q.

Note: TrueType fonts are automatically loaded and do not require an xset command.

You may prefer not to install local copies of the Mathematica fonts on all machines. You can
instead set up a font server with all the necessary Mathematica fonts. The other machines on
the network can then find the fonts as needed by reading them from the Mathematica directory

on the font server. Consult your operating system’s documentation for further information.

On some systems, the font path is limited in length, and it is possible to receive xset: bad
font path element errors even if the fonts are available to the server. In this case, try
reordering the font path and adding the directories for the Mathematica fonts earlier in the
path. The directory $InstallationDirectory/SystemFiles/Fonts/Typel must be listed
before $InstallationDirectory/SystemFiles/Fonts/BDF on the font path for optimal

onscreen performance.

When the X front end prints a notebook, it uses AFM files for the font metrics needed for print-
ing. If you want to print using a particular font not included with Mathematica, you will need the
AFM files for the font. These files are installed in either $InstallationDirectory/
Configuration/Fonts/AFM, /usr/lib/AFM, or /usr/lib/afm. Fonts are normally down-
loaded to the printer by the front end when printing. You may be able to download the fonts
and store them on the printer. See the documentation and programs that came with your

printer for more information.
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If you want to view Mathematica graphics using GhostScript, you need to make GhostScript
aware of the Mathematica fonts. For more information, contact Technical Support by sending
email to support@wolfram.com, or visit support.wolfram.com/mathematica/graphics/export/
ghostscript.html.

Troubleshooting on Unix and Linux

If you have problems using Mathematica on Unix or Linux, check this list for solutions.

m Make sure the CD or DVD is properly mounted with the correct mount command (see
"Mounting a CD or DVD on Unix and Linux"). If the filenames on the CD/DVD appear in the
wrong case, it means the CD/DVD is mounted incorrectly.

Make sure to run the installer from the directory in which it is located.

If the front end password dialog box appears when you launch Mathematica, either Mathemat-
ica could not locate the mathpass file or there was no valid password in the mathpass file. To
resolve this problem, first check that there is a mathpass file in one of these directories:
/usr/share/Mathematica/Licensing, $InstallationDirectory/Configuration/Licensing,
or ~/.Mathematica/Licensing. If you did not find a mathpass file in these locations, follow
the instructions in "Entering a Single-Machine Password" to reenter your password.

If there is a mathpass file in one of those directories, the password or passwords are invalid.
Make sure that your MathID number matches the MathID number used to issue your password.
If your MathID number changes, you will need to contact Customer Service to get a new pass-

word. Contact information is provided in "Registration and Passwords".

By default, the front end runs the command math to start the kernel. If math is not on the path,
then you must use the Kernel Configuration Options command in the Kernel menu to spec-
ify the full pathname of the math command.



138 | System Administration for Single-Machine Licenses

Front end preferences, such as the names of recently opened and saved files, are stored in
~/.Mathematica/FrontEnd. The most convenient way to reset the front end preferences to
their default values is to restart Mathematica using the command mathematica -cleanStart.

This will cause the initialization file to be rebuilt automatically.

Information about your Mathematica layout, such as the locations of text resource files, is
stored in caches. These caches are located in the directory ~/.Mathematica/
FrontEnd/7.0 Caches. A corrupted cache may cause the front end to produce an error or quit
immediately on startup. The most convenient way to reset the caches to their default values is
to use the option -cleanStart at startup. This will cause the Mathematica caches and the
initialization file to be rebuilt automatically. If you want to rebuild your caches but retain your
preferences, hold down Shift during startup. This will delete and rebuild the cache without
rebuilding the front end initialization file.

m Make sure that the fonts are installed on the machine that displays the front end or on a
font server.

m If you see the error xset: bad font path element, either the fonts are not properly
installed on your machine, or your font path is too long and exceeds the allowable limit.
Make sure the fonts are properly installed, or copy the fonts to a directory that is already on
the font path.

For further assistance, check the Technical Support FAQs on the web at support.wolfram.com.
If you are a Site License Administrator, additional Site License Documentation is available at
site.wolfram.com. If you do not find the information you need, please contact Technical Support
by sending email to support@wolfram.com or by calling +1-217-398-6500. Include your license
number in all correspondence. Your license number is located on your electronic or printed
license certificate. It is also available after installation by going to the Help menu and clicking
About Mathematica. You must be a registered user in order to receive installation support.

You must have a current Premier Service subscription to receive Technical Support.
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Mac OS X
Installing Mathematica on Mac OS X

Requirements

Mathematica is available for Windows, Unix, Linux, and Mac OS X. For a complete list of plat-
form availability, visit www.wolfram.com/products/mathematica/platforms.html. Any supported
machine can act as a client for running Mathematica, provided the following two conditions are
met:

m The client has access to the Mathematica files, either locally or from a file server on the
network.

m The license server running MathLM is available on the TCP/IP network.

A license server can also function as its own client. However, this is not recommended. If the
machine has to be rebooted for any reason, the serving of licenses to all other clients on the

network may be disrupted.

Before you install Mathematica as a license server client, MathLM should already be installed
and running on a license server on the network (see "Installing MathLM" for details). To com-
plete the Mathematica installation, you will need to know the name or IP address of the license

server running MathLM.

To install Mathematica on Mac OS X in the Applications folder, you must log on as

administrator.
To Install Mathematica:

1. Insert the DVD. A new window appears on your screen.

e 00 |_| Mathematica =
S 2 items, 486.7 MB available

Wolfram
Mathematica7

Drag the Mathematica icon to Open the Applications folder
the Applications folder to install and start Mathematica

3

Mathematica

Lot
Applications
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2. Drag the Mathematica icon from this window to the location on your hard drive where you
want to install Mathematica. In order for all users to have access to Mathematica, you
should install it in the systemwide Applications folder. You must have administrative
privileges to do this.

Note: If you are installing over a previous version of Mathematica, your existing math-
pass file and custom settings will not be deleted.

3. When all files have been copied, launch Mathematica by opening the folder where you
installed Mathematica and double-clicking the Mathematica icon.

4. Mathematica starts up and the following dialog box appears. Select Network license.
Then enter the name or IP address of the MathLM license server in the text field provided.

[sXN6)

Wolfram Mathematica7

Please personalize your copy of Mathematica

(O Single machine
Name:
Organization:
License number:

A password specific to this machine will be required. Please enter your name
and/or organization and your license number, then click OK to continue.

@ Network license

Enter the name of a server running a Mathematica license manager:

You will obtain a license from a server on your local network each time
Mathematica is launched.

[©) (" quit )

5. Click OK. Mathematica launches and is ready for use.

After you install Mathematica you can place the Mathematica icon into the Dock for easier
access. To do this, start Mathematica, and hold down the Ctrl key while clicking the Mathemat-
ica icon in the Dock. In the popup menu that appears, choose Keep in Dock.

Installing Mathematica for Single-Machine Licenses

Follow these instructions to install a standalone copy of Mathematica that does not get a license
from the license server. Depending on your license type, this may require contacting Wolfram
Research to purchase additional licenses.

To run Mathematica, you must register with Wolfram Research and receive a password. See

"Registration and Passwords" for further information.
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To Install a Single-Machine Copy of Mathematica on Mac OS X:

1. Insert the Mathematica DVD. A new window appears on your screen.

e 0 |_| Mathematica )
X 2 items, 486.7 MB available

Wolfram
Mathematica7

Drag the Mathematica icon to Open the Applications folder
the Applications falder to install and start Mathematica
% fmin
y

Mathematica Applications

2. Drag the Mathematica icon from the window to the location on your hard drive where you
want to install Mathematica.

Note: If you are installing over a previous version of Mathematica, your existing math-
pass file and custom settings will not be deleted.

3. When all files have been copied, launch Mathematica by opening the folder where you
installed Mathematica and double-clicking the Mathematica icon.

4. Mathematica starts up and the following dialog box appears. Select Single machine.
Enter your name, the name of your organization, and your license number (located on
your electronic or printed certificate) in the text fields provided. Click OK when you are
done.

8,006

Wolfram Mathematica’7

Please personalize your copy of Mathematica

@ Single machine

Name:

Organization:

License number:

A password specific to this machine will be required. Please enter your name
and/or organization and your license number, then click OK to continue.

0O) i
() Network license
Enter the name of a server running a Mathematica license manager:

You will obtain a license from a server on your local network each time
Mathematica is launched.

@ Quit
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5. The following dialog box appears showing the MathID number for your machine. To obtain
your password, click the Web button, go to register.wolfram.com, or contact Wolfram
Research (see "Registration and Passwords" for further information). You will need to
supply your license number and your MathID number.

8006

Wolfram Mathematica’7

The quickest and easiest way to obtain a password is to register on the web.
Click the Web button to open your web browser and register to obtain your
password.

MathID: |5116-81117-36320

Password: ( web )

NOTE: The information you provide when you register will be used at Wolfram
Research. Your information will never be sold or provided to anyone else.

(" Other Ways to Register Y ( Back )

6. Enter your password and click OK. You are now ready to start using Mathematica.

Installing Mathematica from a File Server

One convenient way to install Mathematica on a client is to copy the files from a file server on
the network. This is an efficient way of making Mathematica available to a large number of
users without having to supply a DVD to each user.

Before following these instructions, Mathematica should be installed on the file server according

to the instructions in "Network License" and "Single-Machine License".

To Install Mathematica from a File Server:

1. On the client machine, select Go » Connect to Server in the Finder menu.

2. In the dialog box that appears, choose a file server from the list or enter the machine
name or IP address of the file server in the text field. Then click Connect.

e o Connect To Server

Server Address:

afp:/ /macserver.domain.com +| Q@

)

Favorite Servers:

% macserver.domain.com

Remove [ Browse | ( Connect )
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3. Enter your name and password in the dialog box that appears. Then click Connect.

— Connect to the file server "MacServer" as:
-
¢ 4
-

) Guest
™ Registered User

Name: John Doe
Password: eesens
( options... ) ( cCancel ) € Connect )

4. A dialog box appears, showing a list of volumes on the file server. Select the volume in
which Mathematica is installed. Then click OK.

= MacServer
-r
(.-'-’% ,
Select the volumes you wish to mount

Apps
Archives
Drop Box

Mathematica Products

Web Folder

Character Set : ~Western (Mac) B

1 Cancel > ( oK )

5. The volume you selected is mounted on the client machine. Double-click the icon represent
ing the volume.

6. Navigate to the location where Mathematica is installed. Then drag the Mathematica
package from the file server to the location on the client machine where you want to
install Mathematica. In order for all users to have access to Mathematica, you should
install it in the Applications folder. You must log on as administrator to do this.
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Launching Mathematica on Mac OS X

To run Mathematica using a network license, both the client machine and the license server
must be on the network and MathLM must be running.

To Launch Mathematica:

Double-click the Mathematica icon in the directory where Mathematica is installed. Alterna-

tively, if you have placed the Mathematica icon in the dock, single-click the icon.

Open the Terminal application and type the full pathname of the MathKernel binary in the
window that appears. For example, if you installed Mathematica in the Applications folder,
type /Applications/Mathematica.app/Contents/MacOS/MathKernel in a Terminal win-
dow and press Return.

To maintain a centralized location for preferences and password files or to save disk space, you
can run Mathematica directly from a file server. To do this, the client machine does not need to
have any Mathematica files installed locally.

To Run a Copy of Mathematica Installed on a Remote File Server:
1. Connect to a file server on which Mathematica is installed.

2. Double-click the icon representing the volume with the Mathematica files. Then navigate
to the location where Mathematica is installed.

3. Double-click the Mathematica icon in the directory where Mathematica is installed.

The commands MathKernel and Mathematica have several command-line options used to
specify certain configuration information and file locations.

MathKernel

The command MathKernel starts the kernel, which is the part of Mathematica that handles

calculations. This command is also used by the Mathematica front end.
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-initfile file Specifies the name of a file containing commands to be run
on startup.
-lmverbose Prints diagnostic information to stderr on connecting to

the license manager. This is useful for debugging problems
related to the license server.

-mathlink Specifies that the kernel should be run in MathLink mode.
See www.wolfram.com/solutions/mathlink for additional
information about MathLink.

-noinit Specifies that no initialization file should be read at startup.

-password str Specifies a password to use instead of the password or
passwords stored in the mathpass file. The password
should have the form "Iservername" or "machinename mathid
licensenumber password".

-pwfile file Specifies the name of a file that has a valid password.

-run Takes a command to be run on startup as an argument.

MathKernel command-line options.

The command Mathematica runs the Mathematica front end. In order to run Mathematica with
a command-line option, you must start it from the command line using the Terminal applica-
tion.

-cleanStart Tells the front end to ignore caches stored in the directory
~/Library/Mathematica/FrontEnd/7.0 Caches, and rebuilds
the front end preferences file,
~/Library/Mathematica/FrontEnd/init.m.

-mathlink Causes the front end to run in MathLink mode. In MathLink
mode, the front end runs as a child process that is capable
of accepting MathLink packets. This option may be useful
when the front end is used as a typesetting or graphics
rendering service.

-preferencesDirectory dir Specifies the location where preference settings are stored.
The default location is ~/Library/Mathematica.

-topDirectory dir Specifies the location of the Mathematica installation
directory.

Mathematica command-line options.
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Testing the Installation on Mac OS X

The following simple commands allow you to test the installation of Mathematica. Running

these commands does not guarantee that the installation was successful, but a failed command

can indicate that a serious problem occurred during installation.

You should run these tests from a regular user account and not from an account with administra-

tor privileges.

To run Mathematica using a network license, both the client machine and the license server

must be on the network and MathLM must be running.

If you run into problems when doing these tests, see the troubleshooting tips in "Trouble-

shooting on Mac OS X". If you do not find the answer there, check the Technical Support web-

site at support.wolfram.com/mathematica.

1.

To start the kernel, open the Terminal application and type the full
pathname of the MathKernel binary in the window that appears. For example,
if you installed Mathematica in the Applications folder, type /Applications/
Mathematica.app/Contents/MacOS/MathKernel in a Terminal window and press
Return.

In[l]:=

Type N[Pi, 20] and press Return. The number in the output should match the output
shown here.

In[l]:= N[Pi, 20]
Out[l]= 3.1415926535897932385

In[2]:=

To exit the kernel, type Exit and press Return.

. Launch Mathematica by double-clicking the Mathematica icon.

A splash screen with initialization information appears briefly, after which an empty note-
book and the Welcome Screen appear.
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2. Type N[Pi,20]. Then hold down the Shift key and press Enter to evaluate. This should
send the command to the kernel and return the same result as before. The In[1] and
out[1] labels are prepended once the evaluation is completed.

In the notebook window, there should be a horizontal line across the notebook; this is the
horizontal insertion bar. If you do not see one, move the pointer until it becomes a horizon-
tal I-beam and click once to see the insertion bar.

3. Press the Esc key. You should see three small horizontal lines in a column (z). Type int
and press Esc again. You should see an integral sign (f). As an additional font check,
typing \[CheckmarkedBox] and \[CirclePlus] should print the symbols ¥ and e,
respectively. If the symbols show up correctly, the fonts have been properly installed.

4. From the Help menu, choose Documentation Center. The Mathematica Documentation
Center should appear.

Configuration Files on Mac OS X

Mathematica stores preference settings and initialization data in two directories,
$BaseDirectory and $UserBaseDirectory. Within each of these directories are several possi-
ble subdirectories with titles such as FrontEnd, Kernel, and Licensing.
m Global settings that affect all users are stored in subdirectories of the directory
$BaseDirectory. The default value of $BaseDirectory on Mac O0OS X is

/Library/Mathematica. To redefine the location of global preference settings and initializa-
tion data, set the environment variable MATHEMATICA_BASE.

m Settings that only affect a particular user are stored in subdirectories of the directory
$UserBaseDirectory, Which is typically a subdirectory of the user's home directory. The
default value of $UserBaseDirectory on Mac OS X is ~/Library/Mathematica. To redefine
the location of user preferences and initialization data, set the environment variable
MATHEMATICA_USERBASE.

Settings in the directory sUserBaseDirectory override global settings defined in the directory

$BaseDirectory.

In the pathnames that follow, replace the variables $BaseDirectory and $UserBaseDirectory
with the appropriate directories for your system. To find their locations on your system, evalu-

ate the command $BaseDirectory (Or $UserBaseDirectory) in @ Mathematica notebook.

The initialization files used by the kernel contain Mathematica commands that are evaluated at
startup, such as function definitions, packages to load, or kernel option settings. These com-
mands are also available to the Mathematica front end.
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$BaseDirectory/Kernel/init.m

This file is used to initialize the kernel and therefore should store any kernel commands
that are appropriate for all users running the kernel.

$SUserBaseDirectory/Kernel/init.m

This file stores user-specific commands used to initialize the kernel.

Kernel initialization files are not created automatically.

Front end initialization files store preference settings such as the values of global options in the
Option Inspector. These files are automatically updated by Mathematica when you change a
setting in the front end. To make changes to this file, make your changes from within Mathemat-
ica rather than editing the file directly.

$BaseDirectory/FrontEnd/init.m

This file stores systemwide defaults used by all Mathematica front ends. The settings in
this file affect all users. "Systemwide Defaults on Mac OS X" explains how to implement
changes to this global file.

$UserBaseDirectory/FrontEnd/init.m
This file defines settings within the front end that are specific to each user.
$UserBaseDirectory/FrontEnd/7.0 Caches/

This directory within the user's home directory stores information on system settings that
are read by the front end.

Front end initialization files are created automatically.

Passwords are stored in the mathpass file, described in further detail in "Registration and Pass-
words". In the following pathname, replace the variable $InstallationDirectory with the
directory where you installed Mathematica. To find the value of $InstallationDirectory on

your system, evaluate the command $InstallationDirectory in a Mathematica notebook.
$BaseDirectory/Licensing/mathpass
This is the default location for the global password file.

$InstallationDirectory/Configuration/Licensing/mathpass



System Administration for Single-Machine Licenses | 149

This is an alternative location for the global password file.
$UserBaseDirectory/Licensing/mathpass

While this is not normally the location for the password file, a user-specific mathpass file
can be stored here.

Systemwide Defaults on Mac OS X

If you have installed Mathematica in a location where multiple users run it (for example, on a
file server or multi-user machine), then you can set up systemwide defaults for the Mathemat-
ica front end and kernel. This is ideal for setting up Mathematica for use in computer labs and
classrooms. If you share the directory $BaseDirectory across the network, these defaults will

also take effect on local installations that use the shared $BaseDirectory.

The following instructions assume that $BaseDirectory and $UserBaseDirectory have their

default values, /Library/Mathematica and ~/Library/Mathematica, respectively.

1. Launch Mathematica, and set up any changes to the front end that you need. For
example, you may want to modify default file locations, language options, or menu
settings.

2. Quit Mathematica.

3. Copy the file ~/Library/Mathematica/FrontEnd/inittm to the directory /Library/
Mathematica/FrontEnd.
These settings will now be used by the front end unless overridden by the local init.m file stored

in the user's ~/Library/Mathematica/FrontEnd directory.

1. Launch Mathematica, and create a new file.

2. Add any Mathematica commands that should be evaluated on startup. For example, you
may want to add a function definition or display a message at startup. Enter all the com-
mands in the same cell, separating commands with semicolons.

3. Make this cell an initialization cell by selecting the cell bracket and then choosing Cell »
Cell Properties » Initialization Cell.

4. When you have finished making your changes, choose File » Save and select
Mathematica Package from the Save as type popup menu. Then save the file as
/Library/Mathematica/Kernel/init.m.
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These commands will be evaluated when users launch Mathematica. If you added a function

definition, that function will be available to all users.

Troubleshooting on Mac OS X

If the front end password dialog box appears when you launch Mathematica, either Mathemat-
ica could not locate the mathpass file or there was no valid password in the mathpass file. To
resolve this problem, first check that there is a mathpass file in one of these directories:
/Library/Mathematica/Licensing, $InstallationDirectory/Configuration/Licensing, or
~/Library/Mathematica/Licensing. To find the exact location of $InstallationDirectory on
your machine, evaluate the command $InstallationDirectory in a notebook. If you did not
find a mathpass file in these locations, follow the instructions in "Entering a Single-Machine

Password" to reenter your password.

If there is a mathpass file in one of those directories, the password or passwords are invalid.
Make sure that your MathID number matches the MathID number used to issue your password.
If your MathID number changes, you will need to contact Customer Service to get a new pass-

word. Contact information is provided in "Registration and Passwords".

Front end preferences, such as the locations of recently opened and saved files, are stored in a
front end initialization file called init.m. This file is located in the directory ~/Library/
Mathematica/FrontEnd. If you need to reset the front end preferences to their default values,
hold down Shift+Option during startup. This will cause the initialization file to be rebuilt automat-
ically.

Information about your Mathematica system layout, such as the locations of text resource
files and help files, is stored in caches. These caches are located in the directory ~/Library/
Mathematica/FrontEnd/7.0/ Caches.

A corrupted cache may cause the front end to produce an error or quit immediately on startup.
The most convenient way to restore the caches to their default values is to hold down
Shift+Option during startup. This will cause the Mathematica caches and the initialization file to

be rebuilt automatically.
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If you want to rebuild your caches but retain your preferences, hold down Shift during startup.
This will delete and rebuild the cache without rebuilding your front end initialization file.

For further assistance, check the Technical Support FAQs on the web at support.wolfram.com.
If you are a Site License Administrator, additional Site License Documentation is available at
site.wolfram.com. If you do not find the information you need, please contact Technical Support
by sending email to support@wolfram.com or by calling +1-217-398-6500. Include your license
number in all correspondence. Your license number is located on your electronic or printed
license certificate. It is also available after installation by going to the Help menu and clicking
About Mathematica. You must be a registered user in order to receive installation support.

You must have a current Premier Service subscription to receive Technical Support.








